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General Abstract 

Background: The number of cancer survivors across North America is increasing, with estimates 

indicating that this population will grow to nearly 19 million individuals by the end of 2020. This 

increase can be attributed, in part, due to improvements in cancer treatments, of which radiation 

therapy is most commonly used. Unfortunately, exposure to radiation also increases the risk of 

secondary cancer development long-term. Moreover, obesity and physical inactivity are 

prevalent, modifiable, risk factors among cancer survivors, with both factors being linked to 

decrements in quality of life, increased cancer risk, and greater mortality risk. To date, there has 

been promising epidemiological and clinical data highlighting the role of exercise as a way to 

mitigate cancer risk and improve survival; however, longitudinal studies are lacking and the effects 

of radiation in these studies have been largely ignored. Therefore, there is a major clinical need 

to directly evaluate the combinatory long-term effects of radiation, exercise, and/or obesity to 

reveal their implications on healthspan, cancer incidence, and survival. Recent pre-clinical work 

from our group has shown that after being exposed to radiation, endurance exercise prevented 

several negative alterations to hematopoietic stem cells and their niche caused by high-fat diet 

(HFD)-induced obesity. We also showed that leukemic blast viability in vitro was greater when 

cultured in bone marrow supernatant from mice with HFD-induced obesity compared to bone 

marrow supernatant from mice without HFD-induced obesity. It is unknown, however, whether 

these findings extend to alterations in cancer risk across the lifespan. As such, the purpose of this 

study was to evaluate the effects of lifelong exercise and diet-induced obesity on healthspan, 

cancer incidence, and survival in an established mouse model of radiation-induced cancer.  

Methods: Male CBA mice (n=80) were randomly divided into either a control diet (CTRL; n=40) 

of 45% high-fat diet (HFD; n=40) and then further divided into either a sedentary group (SED; 

n=20) or exercise-trained group (EX; n=20). At age 13 weeks, all mice were exposed to a cancer 

inducing dose of whole-body ionizing radiation (3 Gy). A healthspan index score and endpoint 

monitoring were conducted throughout the study by blinded investigators.  
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Results: When normalized to CTRL/SED, the highest healthspan score was in the CTRL/EX 

(score = +2.5), followed by HFD/EX (score = +1) and lastly HFD/SED (score = -0.5). Cancer 

incidence was significantly higher in the HFD/SED group when compared to the CTRL/EX group 

(p<0.05) and a trend for higher cancer incidence for HFD/SED was observed when compared to 

the CTRL/SED group (p=0.079). There was no significant difference between the HFD/SED and 

HFD/EX group in cancer incidence (p>0.05). Overall survival was significantly higher in the 

HFD/SED group compared to CTRL/SED group (p<0.05); however, risk of cancer-related 

mortality was 1.6-times higher in the HFD/SED group compared to the CTRL/SED group 

(RR=1.60; 95% CI, 1.00-2.56; p=0.0495) and 1.68-times that of the CTRL/EX group (RR=1.68; 

95% CI, 1.02-2.78; p=0.0415).  

Conclusion: Our findings show that lifelong exercise training resulted in higher healthspan index, 

lower cancer incidence, and lower risk of cancer-related mortality following radiation exposure, 

with these effects being largely reversed by HFD-induced obesity. This study provides the 

rationale for future studies to uncover cellular and molecular mechanisms that could be underlying 

these results. Moreover, this study presents a proof of concept for the consideration of clinical 

studies in cancer survivors examining exercise as an intervention to reduce the long-term effects 

of radiation.



   
 

 1 

 

Chapter I: Literature Review 

Introduction 

According to the Canadian Cancer Society (2019), the 5-year survival rate following cancer 

diagnosis is currently 63% and cancer mortality rates have decreased by 32% and 17% in males 

and females, respectively. One reason for this increase in survivorship can be attributed to 

advances in cancer screening, detection, and therapy. One such treatment is radiation therapy 

which is used by two-thirds of cancer patients (American Cancer Society, 2013). Radiation is an 

effective anti-tumour therapy, however, it also can lead to adverse long-term health effects in 

healthy tissues including toxicity and increased cancer risk (Dracham et al., 2018; Kleinerman et 

al., 1995). Indeed, evidence from studies following atomic bomb survivors have shown that 

radiation is strongly associated with increased cancer incidence later in life (D. L. Preston et al., 

2007; Dale L Preston et al., 1994). The most common radiation-induced malignancy is acute 

myeloid leukemia (AML) (Preston et al., 1994), which is derived from mutations in the extremely 

radiation-sensitive hematopoietic stem cells (HSCs) (Williams & McBride, 2011). While AML is 

the most common radiation-induced cancer, several other types of cancer have also been strongly 

linked with radiation exposure (Braunstein & Nakamura, 2013; D. L. Preston et al., 2007). Despite 

these strong links between radiation and cancer, there is a large amount of interindividual 

variability in radiation-induced cancer latency with some persons exposed to radiation never 

developing cancer at all.  As such, recent research efforts have focused on identifying genetic 

and modifiable risk factors that contribute to radiation-induced cancer risk.  

Two modifiable risk factors that have been epidemiologically linked to increased risk of a 

variety of cancers, and which are prevalent among cancer survivors, are obesity and physical 

inactivity. Further, obesity and physical inactivity contribute to reduced quality of life (Wolin et al., 

2010), and longevity (Schmid & Leitzmann, 2015) among cancer survivors. According to the 

National Cancer Institute (2017), the number of cancer survivors with obesity is increasing 
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steadily. There is a limited understanding, however, with regards to the extent in which obesity 

and physical inactivity impact healthspan, the incidence of radiation-induced malignancies, and 

longevity following radiation exposure. As such, a critical need exists to develop a better 

understanding of how modifiable risk factors interact with radiation exposure, such that we can 

provide cancer survivors with personalized care to enhance overall quality of life and decrease 

secondary cancer risk induced by radiation. 

The Hematopoietic Stem Cell (HSC) Niche 

HSCs are the most primitive cells in the hematopoietic system and exist in our bone marrow 

within a specialized microenvironment or niche. A niche can be defined as a local tissue 

microenvironment that contains all the components required for stem cell function and regulation 

(Morrison & Spradling, 2008). The idea that an HSC niche existed was first introduced by 

Schofield in 1978. Prior to the postulate of an HSC niche, it was believed that HSCs were derived 

from the spleen according to several colony forming units – spleen (CFU-S) assays. Schofield 

demonstrated that the HSC population in the bone marrow had better hematopoietic reconstitution 

than in the spleen after radiation exposure (Schofield, 1978). As such, Schofield’s work was the 

first to provide support for an HSC niche in the bone marrow that contains cells with enhanced 

reconstitution potential. The HSC niche is composed of a variety of different cell types of which 

the most prominent are HSCs and their progeny, mesenchymal stem cells (MSCs), and 

endothelial cells (Asada et al., 2017). These cell types work together to maintain and regulate 

hematopoiesis within the bone marrow during steady state and in response to stress.  

HSCs can exist in a quiescent or active state and exhibit their stemness via their ability to self-

renew and differentiate into all mature hematopoietic cells. Briefly, HSCs can differentiate directly 

into platelets, down the myeloid lineage to form red blood cells and innate immune cells, or down 

the lymphoid lineage to form adaptive immune cells (Y. Zhang et al., 2018). The distribution of 

HSCs throughout the bone marrow, however, is not homogeneous. Earlier work indicated that 

roughly 20% of HSCs reside in an endosteal niche, with the other 80% residing in a perivascular 
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niche, highly enriched in sinusoidal vessels (Kiel et al., 2005). It was observed that the more 

quiescent HSCs resided near arterioles in the endosteal niche, whereas the more active and 

proliferative HSCs resided near the leaky sinusoids and perivascular cells in the perivascular 

niche (Itkin et al., 2016; Kunisaki et al., 2013). Both niches played important yet functionally 

distinct roles. Briefly, the endosteal niche had been shown to be important in supporting HSC 

regulation and expansion, as well as enhancing HSC engraftment post-transplantation (L. M. 

Calvi et al., 2003; J. Zhang et al., 2003), whereas the perivascular niche was an excellent source 

of stem cell factor (SCF) which is secreted by perivascular cells and is important in the promotion 

and maintenance of HSCs (Ding et al., 2012). This notion of two distinct HSC niches has been 

recently challenged, with more recent evidence suggesting that these sub-niches are more 

dynamic than originally thought and can adapt to various environmental stimuli such as stress or 

cancer (Laura M. Calvi & Link, 2015). In addition, it has been shown that nearly all HSCs reside 

near sinusoidal vessels and away from bone surfaces (Acar et al., 2015), but this does not rule 

out the importance of the endosteal niche as it too is supplied by sinusoidal vessels and stromal 

cells that are vital for HSC function (Baccin et al., 2020). Taken together, the HSC niche is 

represented by a highly complex, dynamic and heterogeneous network of cells and regulating 

factors that help to achieve homeostasis in response to different environmental stimuli (Figure A).   
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Figure A. Simplified overview of the HSC niche. The HSC niche is composed of a highly 

complex, dynamic and heterogeneous network of cells and regulating factors that help in the 

maintenance, maturation and/or mobilization of HSCs. Common regulating factors released 

predominantly from endothelial cells and LEPR+-MSCs include CXCL12 and SCF. MSCs have 

also been shown to differentiate into either osteoblasts or adipocytes. The coordination of cellular 

communication among the various cell types in the HSC niche helps to achieve homeostasis in 

response to different environmental stimuli. Created with BioRender.com. 

 

At the same time as Schofield was developing his stem cell niche hypothesis, work by Dexter, 

Allen and Lajtha (1977) provided new evidence that another population of stem cells found in the 

HSC nice – MSCs - play a large role in HSC regulation. Specifically, they showed that in a co-

culture of HSCs and MSCs, HSCs had enhanced proliferation and expansion compared to HSCs 

cultured without MSCs (Dexter et al., 1977). MSCs within the bone marrow are also 

heterogeneous (Severe et al., 2019), with some of these subsets (i.e. leptin receptor; LEPR+-
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MSCs) acting as sources of SCF and CXCL12, which is also important in the promotion and 

maintenance of HSCs (Crane et al., 2017; Zou et al., 1998). In addition to their paracrine role in 

HSC regulation, MSCs are able to self-renew and possess the ability to differentiate into 

osteoblasts, adipocytes, or chondrocytes. Osteoblasts and adipocytes in particular, have also 

been proposed to be important in HSC regulation. While it was originally thought that osteoblasts 

were directly involved in HSC maintenance, osteoblast ablation showed subsequent depletion of 

early lymphoid progenitors but no effect on HSC frequency (Visnjic et al., 2004; J. Zhu et al., 

2007). In a gain of function study using strontium treatment to increase osteoblasts, there was no 

acute change to HSC content (Lymperi et al., 2008). In addition, osteoblasts express minimal 

amounts of CXCL12 and SCF (Ding et al., 2012; Ding & Morrison, 2013; Greenbaum et al., 2013), 

providing support that osteoblasts either do not regulate HSCs at all or rather, indirectly regulate 

them via other niche cells. On the other hand, there is much stronger support for the direct role of 

adipocytes (which are derived primarily from LEPR+-MSCs) on HSC regulation. Marrow adipose 

tissue (MAT) is distributed throughout the long bone cavities in a distal to proximal manner during 

postnatal development (Emery & Follett, 1964). By age 25 in humans, MAT makes up 

approximately 70% of the bone marrow and its content continues to increase throughout the 

lifetime (Scheller et al., 2014). A seminal study by Naveiras et al. (2009), evaluated the effect of 

MAT on hematopoiesis. Using A-ZIP/F1 “fatless” mice which are incapable of forming adipocytes, 

they showed that decreased MAT contributed to greater HSC frequency, cycling capacity, and 

CFUs, as well as enhanced engraftment of donor cells post bone marrow transplant, compared 

to wild-type mice (Naveiras et al., 2009). Furthermore, when mice were treated with a known 

inhibitor of adipogenesis (bisphenol A diglycidyl ether - BADGE), there was an increase in 

hematopoietic recovery and function compared to mice not treated with the inhibitor (Naveiras et 

al., 2009; R. J. Zhu et al., 2013). While these studies suggest that adipocytes in the bone marrow 

are negative regulators of hematopoiesis, relatively newer evidence from Boyd and colleagues 

(2017) showed that MAT may have some benefits on hematopoiesis as well, especially in the 
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context of AML. In their study, patients with AML had lower MAT relative to healthy controls and 

concurrently, a decrease in HSC maturation down the myeloid lineage. Further, MSCs collected 

from patients with AML lacked adipogenic differentiation. On the other hand, in healthy controls, 

MAT supported myelo-erythroid maturation while simultaneously inhibiting AML progenitors. 

Importantly, they also demonstrated that the administration of PPARg (an agonist of 

adipogenesis) to AML mice, induced MAT which in turn improved myelo-erythroid maturation 

(Boyd et al., 2017). Taken together, while MAT appears to negatively regulate hematopoiesis 

under homeostatic conditions, these new findings suggest that it may play a key role in HSC 

regulation in the context of AML. 

Ionizing Radiation and its Effects on the HSC Niche 

Ionizing radiation (IR) is the energy released by atoms as they disintegrate. This energy can 

then travel via electromagnetic waves – either gamma or x-rays. Humans are exposed to low 

levels of background IR daily; however, in the past several decades human radiation exposure 

has increased dramatically, mostly due to its increased use for medical applications. Indeed, 

radiation therapy is used in roughly 67% of cancer patients in the United States (American Cancer 

Society, 2013). The units for IR are Gray (Gy - the amount of energy (Joules) absorbed per 

kilogram (kg) of matter, and the cancer type, tumour size, tumour location, and cancer stage 

dictate the amount of IR administered to a patient during radiation therapy (American Cancer 

Society, 2014). Depending on these factors, patients can receive IR doses ranging from 20-80 

Gy, which is delivered in fractionated doses of typically 1.5-2 Gy over several treatments to reduce 

toxicity to healthy cells (Benderitter et al., 2014). In many cancer cases, radiation therapy is focally 

administered, however, in the case of hematological cancers, a bone marrow transplant may be 

required which involves myeloablative total body irradiation. Typically, total body irradiation is 

delivered in 8-12 fractionated doses, three times a day, over the course of four days for a total 

administration of between 12-15 Gy (Seung et al., 2013; Storb et al., 1994).  
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IR is geno- and cytotoxic which makes it an effective cancer therapy. Unfortunately, these 

characteristics also increase the likelihood of malignant transformations in healthy cells which 

could develop into secondary cancers. According to the Life Span Study, which longitudinally 

tracked close to 95 thousand Hiroshima and Nagasaki atomic bomb survivors, there were 231 

confirmed cases of leukemia - of which acute myeloid leukemia (AML) made up 103 of those 

cases (45%) - amongst those exposed to between 0 and 4 Gy of IR (Dale L Preston et al., 1994). 

Furthermore, Richardson and colleagues (2009) showed that among these atomic bomb 

survivors, it can be expected that 310 of them will develop and die of some form of leukemia 

secondary to the late effects of radiation exposure, of which 124 of these deaths (40%) will be 

caused by radiation-induced AML (Richardson et al., 2009). Together, these results suggest that 

AML is the most common radiation-induced malignancy, although other malignancies are also 

prevalent (Dale L Preston et al., 1994). Indeed, other studies have shown that persons exposed 

to radiation at age 30 have increased radiation-associated cancer risk (35% per Gy in men and 

58% per Gy in women) at multiple sites throughout the body by age 70 (D. L. Preston et al., 2007). 

Specifically, other cancer types that have been associated with radiation exposure include (but 

are not limited to): breast, colorectal, thyroid, endometrial, cervical, and central nervous system 

cancers (Braunstein & Nakamura, 2013), as well as liver cancer secondary to radiation-induced 

liver disease (Kim & Jung, 2017; Koay et al., 2018) Combined with the fact that radiation-induced 

cancer risk has not improved despite advances in radiotherapy technology (Schaapveld et al., 

2015), it is evident that the late effects of radiation therapy, including radiation-induced cancer, 

are of major clinical concern. 

Radiation-induced malignancy is a multi-stage process that involves a combination of the 

immediate, direct and long-term, indirect effects of IR. The direct effects of IR include an increase 

in oxidative stress leading to DNA damage and mutations (Azzam et al., 2012). HSCs are 

particularly susceptible to IR. Mice exposed to 6.5 Gy of total body IR had a decrease in HSC 

quantity, impaired HSC expansion, and an increased expression of senescence markers (Wang, 
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Schulte, LaRue, Ogawa & Zhou, 2006). HSCs exposed to 4 Gy of IR in vitro had an increase in 

reactive oxygen species (ROS; indicator of oxidative stress), DNA damage (gamma-H2AX foci 

per cell), and cell death compared to controls (0 Gy) (Yamaguchi & Kashiwakura, 2013). 

Moreover, exposure to total body IR has been shown to impair HSC self-renewal, repopulating 

capacity, and induce myeloid skewing (Shao et al., 2014). This in turn, may increase the risk of 

developing AML. Interestingly, even low doses of IR (0.02 Gy) produced persistent oxidative 

stress, decreased HSC self-renewal, an increase in myeloid-primed quiescent HSCs, and an 

increase in myeloid cells (Rodrigues-Moreira et al., 2017). The indirect effects of IR can 

exacerbate cancer risk introduced by the direct effects. Indirect effects are the result of a 

prolonged inflammatory response produced by surviving irradiated cells and/or the progeny of 

previously irradiated cells (Lorimore et al., 2003). These cells release various inflammatory 

cytokines (i.e. IL-1b, IL-6, TNF-a, CXCL-12, TGF-b, SDF-1, CXCR4), which lead to an 

inflammatory environment, oxidative stress, and tissue damage/cell death (Kim et al., 2014). 

Taken together, both the direct and indirect effects of IR, even at low doses, help to produce a 

pro-inflammatory and oncogenic milieu in the bone marrow which can contribute to an increase 

in the incidence of radiation-induced cancers. 

It is clear that IR, through both its direct and indirect effects, is detrimental to the bone marrow 

and plays a large role in cancer promotion. Given the increasing number of cancer survivors and 

frequency in which radiation therapy is used in cancer treatments, it is no surprise that the long-

term effects of such treatments are a major clinical concern. Perhaps, even more concerning is 

that despite improvements in IR delivery, radiation-induced cancer incidence in cancer survivors 

treated with radiation therapy has not improved (Schaapveld et al., 2015). While these late effects 

of radiation on their own present new and worrisome challenges for the cancer survivor 

population, it should be noted that not all persons exposed to radiation therapy will develop 

secondary cancers, and there is large variability in the timespan between radiation exposure and 

secondary cancer incidence in those who do. As such, developing a better understanding of the 
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genetic and modifiable risk factors responsible for altered cancer risk following radiation exposure 

would provide the opportunity for increased surveillance and the development of targeted 

interventions in individuals who are at increased risk.  

The Effects of Obesity on the HSC Niche  

Obesity in both Canada and the United States is an epidemic. Specifically, in Canada, we 

have seen a marked increase in individuals with obesity in the past three decades. According to 

Obesity Canada (2019), over 30% of Canadians have obesity which is predicted to result in nearly 

$9 billion dollars in healthcare costs by 2021 (Obesity Canada, 2019). The obesity epidemic 

extends to cancer survivors as the National Cancer Institute (2017) indicates that the number of 

cancer survivors with obesity is increasing. This is problematic as obesity has been 

epidemiologically linked to about 20% of cancer cases including breast, liver, colorectal, and 

leukemic cancers, to name a few (Wolin et al., 2010). Moreover, evidence from pre-clinical models 

have shown that  aged mice with obesity have increased mortality, overall reduced healthspan, 

and increased spontaneous cancer incidence (Schafer et al., 2019). Despite the increasing 

incidence of cancer survivors with obesity, relatively little attention has been paid to the effects of 

obesity on cancer recurrence in long-term cancer survivors; particularly those exposed to 

radiation.  

Obesity is known as a chronic low-grade inflammatory condition. It is characterized by an 

abnormal or excessive increase in adipose tissue, which in turn leads to the release of pro-

inflammatory cytokines (IL-6, TNF-a), and is associated with insulin resistance (Ellulu et al., 2017; 

Meijer et al., 2011). Obesity is associated with an increase in circulating leukocytes, in humans 

(Dixon & O’Brien, 2006; Niemiro et al., 2016) and mice (Singer et al., 2014). Since these mature 

circulating blood cell populations are short-lived and derived from HSCs, recent work has focused 

on the effects of obesity on hematopoiesis. Mice fed a 45% high-fat diet (HFD) for 18 weeks 

experienced a significant decrease in self-renewing HSCs, an increase in multipotent progenitor 
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cells (MPPs), and impaired HSC reconstitution upon transplantation into control diet fed mice 

(Van Den Berg et al., 2016). Obesity also induces myeloid lineage skewing as mice fed a HFD 

for 16 weeks had significant increases in pro-inflammatory monocytes and cytokines, as well as 

an increase in myeloid cells after serial bone marrow transplantation compared to mice fed a 

control diet (Singer et al., 2014). This aberrant myelopoiesis was found to begin as early as six 

weeks following commencement of a HFD and was dependent on cell-autonomous Toll-like 

receptor 4 (TLR4) (Liu et al., 2018). Importantly, the authors also showed that a HFD contributed 

to delayed leukocyte recovery following bone marrow injury using fluorouracil (5-FU) (Liu et al., 

2018). Together these findings suggest that obesity induces activation and aberrant myelopoiesis 

in HSCs resulting in premature exhaustion of the most primitive HSC pool. Since AML is a result 

of uncontrolled expansion of myeloid lineage cells, these findings suggest that obesity may 

accelerate AML by enhancing myelopoiesis. This hypothesis has been supported by 

epidemiological data indicating that obesity is strongly associated with several types of leukemia, 

particularly AML (Castillo et al., 2012). 

Recent work from our group has begun to address the effects of obesity on hematopoietic 

recovery following acute radiation-induced hematopoietic stress. We recently showed that mice 

who were fed a 45% HFD for 12 weeks, remained sedentary, and were exposed to a 3 Gy dose 

of IR at age 13 weeks, had higher MAT and a pro-inflammatory bone marrow environment, as 

well as lower bone marrow cellularity and pro-hematopoietic paracrine factors (Emmons et al., 

2019). Moreover, there was greater viability of KG-1a leukemic blasts when cultured in bone 

marrow supernatant from those HFD-fed mice (Emmons et al., 2019). These results indicate that 

obesity delays hematopoietic recovery, potentially by creating pro-inflammatory alterations in the 

HSC niche, and a paracrine bone marrow environment that promotes the expansion of leukemic 

blasts in vitro. It remains unknown, however, whether these short-term alterations in 

hematopoiesis and the bone marrow result in increased incidence of AML or other cancers long-

term after being exposed to radiation.  
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The Effects of Exercise on the HSC Niche 

Exercise is generally accepted as anti-inflammatory, with studies suggesting that it may be 

beneficial at reducing the degree of inflammation associated with chronic pro-inflammatory 

conditions such as obesity (You et al., 2013), and in cancer patients and survivors (LaVoy et al., 

2016). Although the effects of exercise on mature hematopoietic cells have received considerable 

attention, limited work has focused on the role of exercise in regulating hematopoiesis. Our lab 

recently examined the effects of an acute exercise bout on HSCs. We found that acute treadmill 

exercise increased HSC content in the spleen within 48 hours post-exercise (Emmons et al., 

2016). In addition, 15 minutes post-exercise, there was an increase in HSC content in circulation, 

which closely mirrors the results from human studies (Bonsignore et al., 2002). Furthermore, we 

showed an increase in gene expression for pro-hematopoietic factors such as CXCL12 in muscle, 

and proliferating HSCs, MPPs, and MSCs in the bone marrow (Emmons et al., 2016). Conversely, 

a more recent study showed that mice who participated in voluntary wheel-running for 6 weeks 

had a decrease in circulating leukocytes at baseline compared to sedentary mice, but after 

undergoing cecal ligation and puncture (sepsis model), had improved emergency hematopoiesis 

(increase in circulating leukocytes) and survival compared to sedentary mice (Frodermann et al., 

2019). We also previously showed that mice exposed to 10 weeks of treadmill exercise training 

had significantly more HSCs and CFUs, and an associated decrease in MAT (Baker et al., 2011). 

Similarly, we showed that mice exposed to eight weeks of treadmill exercise training had higher 

HSC quantity and whole bone marrow cell proliferation, as well as a decrease in pro-inflammatory 

cytokines in the bone marrow compared to sedentary mice (De Lisio & Parise, 2012). This 

therefore suggests that exercise is involved is altering the HSC niche and acts as a regulator of 

hematopoietic mobilization.    

Exercise has also been shown to attenuate or reverse the effects of obesity on the bone 

marrow. Using a mouse model of colorectal cancer (CRC), our lab showed that mice who were 

fed a HFD for 8 weeks to induce obesity, then permanently switched to a control diet both during 
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and post CRC induction, and then started a 22 week long treadmill exercise training intervention, 

had reduced CRC incidence, MAT, bone marrow inflammatory markers, and myeloid skewing, as 

well as more quiescent and active HSCs compared to mice undergoing the same dietary 

intervention except remained sedentary (Emmons, Xu, et al., 2019). A main way in which exercise 

exerts its effects is through the MSC populations. For instance, exercise-trained mice have more 

osteoblasts and less adipocytes compared to sedentary mice (Baker et al., 2011; Marędziak et 

al., 2015). Additionally, work by Styner and colleagues showed in mice that 6-weeks of voluntary 

wheel running was able to attenuate increases in MAT and decrements to bone structure induced 

by a MAT agonist (Styner et al., 2015) or HFD (Styner et al., 2014, 2017). This suggests that 

exercise induces positive changes to the bone marrow, in part, by stimulating MSC differentiation 

down the osteoblastic region and reducing MAT. 

 It is therefore suggested that in both disease-free and disease contexts, exercise can play a 

role in positively stimulating hematopoiesis. In the context of radiation, however, there have only 

been a few studies to analyze the effects of exercise on hematopoiesis. We demonstrated that 

exercise-trained mice exposed to an acute challenge of radiation (1 and 2 Gy), had less 

expression of apoptotic markers and cell death in the bone marrow compared to sedentary 

controls, suggesting that exercise may protect bone marrow cells from radiation-induced death 

(De Lisio et al., 2011). We also demonstrated that pre-conditioning mice with treadmill exercise 

training before being exposed to radiation for bone marrow transplant, resulted in a greater 

hematopoietic reconstitution and overall survival compared to sedentary mice (De Lisio et al., 

2013). To more precisely elucidate the cellular response to radiation in the bone marrow, our lab 

recently exposed exercise-trained mice and those with obesity to a single high dose of radiation 

and quantified various hematopoietic and stromal cell populations (Emmons et al., 2019). In this 

study, we demonstrated that exercise-trained mice, regardless of diet, had lower MAT and 

inflammatory cytokines in the marrow, as well as higher bone marrow cellularity and HSC content. 

Importantly, with respect to cancer incidence, there was an increase in KG-1a leukemic blast cell 
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viability in vitro, when cultured in bone marrow paracrine factors from mice with obesity after 24 

hours (Emmons, Ngu, et al., 2019). Taken together, there is some evidence that shows support 

for exercise as a possible strategy to mitigate the effects of radiation of the HSC niche, especially 

at acute timepoints. Yet, it still remains unknown whether these effects can translate long-term to 

decrease cancer incidence and mortality. 

Statement of Problem and Rationale 

To summarize the above literature: The number of physically inactive cancer survivors with 

obesity who are exposed to radiation is rising. This is problematic as these factors can increase 

the lifetime risk of developing various secondary cancers, but specifically those that arise from 

HSCs, such as AML. HSCs are extremely radio-sensitive and they reside in a highly complex and 

diverse niche that dynamically adapts to environmental stimuli. Radiation is geno- and cytotoxic, 

exerting its deleterious effects both directly by causing DNA damage and indirectly through 

exacerbating the inflammatory profile of the HSC niche and inducing myeloid skewing. Similarly, 

obesity has been shown to increase HSC niche inflammation and induce myeloid skewing. This 

suggests that obesity can exacerbate an already oncogenic environment induced by radiation. 

Exercise on the other hand, has been shown to be beneficial for the HSC niche and mitigates 

both the negative cellular effects of radiation and obesity, suggesting that it could be a good 

strategy for improving healthspan as well as decreasing radiation-induced cancer incidence and 

mortality.  

Within the exercise oncology field, most of the work has focused on physical and mental 

health-related outcomes (Campbell et al., 2019), while studies that have looked at exercise, 

cancer incidence and survival, have been largely epidemiologically based and focused on 

populations of patients with breast, prostate, and colorectal cancer, irrespective of treatment 

(Cormie et al., 2017). No previous studies have examined the direct effects of exercise, or obesity 

in the context of long-term effects of radiation exposure on healthspan, cancer incidence, and 
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survival. As such, the purpose of this study will be to address this gap using a pre-clinical 

established model of radiation-induced cancer (Major & Mole, 1978; Rivina et al., 2016).  

Objective & Hypotheses 

Our overall objective is to directly quantify the effects of lifelong-exercise training and/or HFD-

induced obesity, in combination with a cancer inducing dose of radiation, on healthspan, cancer 

incidence, and survival in a mouse model of radiation-induced cancer. We hypothesize that 

sedentary mice with HFD-induced obesity, will exhibit greater cancer incidence as well as 

decreased healthspan and survival, compared to lean, exercise-trained mice after radiation 

exposure. Furthermore, we predict that exercise-trained mice with HFD-induced obesity will have 

greater healthspan and survival, as well as decreased cancer incidence compared to sedentary 

mice with HFD-induced obesity, but similar to that in lean, sedentary mice after radiation 

exposure.  
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Abstract 

The increasing number of long-term cancer survivors exposed to radiation therapy as part of 

their treatment is increasing the risk of secondary cancer development. Furthermore, obesity and 

physical inactivity are prevalent, modifiable, risk factors in this population that have also been 

shown to increase cancer risk. However, whether obesity and strategies such as lifelong exercise 

alter radiation-induced cancer incidence, overall healthspan, and survival, remains to be explored. 

As such, we evaluated the effects of lifelong exercise and diet-induced obesity on these outcomes 

in a mouse model of radiation-induced cancer. Male CBA mice were randomly divided into either 

a control diet/sedentary group (CTRL/SED), 45% high fat diet/sedentary group (HFD/SED), 

control diet/exercise group (CTRL/EX), or 45% high fat diet/exercise group (HFD/EX), and 

exposed to a cancer-inducing dose of whole body ionizing radiation (3 Gy). Healthspan index 

scores and endpoint monitoring was conducted throughout the study. When normalized to 

CTRL/SED, the highest healthspan score was in CTRL/EX (score = +2.5), followed by HFD/EX 

(score = +1), and HFD/SED (score = -0.5). Cancer incidence was higher in HFD/SED compared 

to CTRL/EX (p<0.05) and there was a trend for lower incidence when compared to CTRL/SED 

(p=0.079). There was no difference between the HFD/SED and HFD/EX groups (p>0.05). Overall 

survival was higher in HFD/SED compared to CTRL/SED (p<0.05); however, risk of cancer-

related mortality was increased in the HFD/SED group by 1.6-times that of CTRL/SED (RR=1.60; 

95% CI, 1.00-2.56; p=0.0495) and 1.68-times that of CTRL/EX (RR=1.68; 95% CI, 1.02-2.78; 

p=0.0415). Here we show that lifelong treadmill exercise training improved healthspan, lowered 

cancer incidence, and reduced the risk of cancer-related mortality with these effects being 

reversed in HFD-induced obesity in a mouse model of radiation-induced cancer. This study 

presents a proof of concept for the consideration of clinical studies in cancer survivors examining 

exercise as an intervention to reduce the long-term effects of radiation.   
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Introduction 

Cancer survival rates have been steadily increasing in North America, with the 5-year survival 

rate reported to be 63% and 69% in Canada and the United States, respectively (Canadian 

Cancer Society, 2019; American Cancer Society 2019). Radiation therapy, which is undergone 

by two-thirds of patients with cancer (American Cancer Society, 2013), is a standard anti-tumour 

therapy. Conversely, its geno- and cytotoxicity and lack of specificity result in adverse long-term 

health effects in non-cancer tissues, thereby increasing the likelihood of developing secondary 

cancers. Despite improvements in radiation delivery, the incidence of radiation-induced cancers 

and morbidity have not improved (Dracham et al., 2018; Rubinsak et al., 2018; Schaapveld et al., 

2015). The most common radiation-induced malignancy is acute myeloid leukemia (AML) 

(Preston et al., 1994). AML derives from mutations in hematopoietic stems cells (HSCs) - found 

in the HSC niche within the bone marrow - which are particularly susceptible to radiation damage 

(Williams & McBride, 2011). As such, the late effects of radiation therapy, including increased 

secondary cancer risk, organ toxicity, and morbidity, are an emerging major clinical concern.  

A large body of evidence has focused on explaining the cellular changes induced by radiation, 

as well as the effects of radiation dose that could lead to secondary cancers (Braunstein & 

Nakamura, 2013; Little, 2000; Shah et al., 2012). However, interindividual variability in both the 

incidence and latency of cancer development in persons exposed to radiation suggests that 

individual modifiable risk factors should also be considered when investigating the potential long-

term impact and response to radiation exposure. To date, the interactions between modifiable 

risk factors and radiation-induced cancer incidence have been largely ignored. Two modifiable 

risk factors that have been linked to increased cancer risk, which are prevalent among cancer 

survivors, are obesity and physical inactivity (Greenlee et al., 2016). In the context of radiation, 

previous work from our group has demonstrated that high fat diet (HFD)-induced obesity 

increased marrow adipose tissue, pro-inflammatory cytokines, and leukemic blast viability in vitro 

after radiation exposure (Emmons et al., 2019). In addition, it has been shown that a HFD alone 
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can increase myeloid skewing and decrease hematopoietic recovery after injury (Liu et al., 2018), 

mimicking the effects of radiation (Shao et al., 2014). Thus, obesity may exacerbate the 

deleterious long-term effects of radiation and as such, strategies such as exercise training, may 

mitigate these effects. Clinical evidence indicates that exercise training in cancer survivors is safe, 

and has numerous physical and psychological cancer health-related benefits (Campbell et al., 

2019), while epidemiological (Cormie et al., 2017), and preclinical studies using various cancer 

models have shown that exercise training can reduce cancer incidence and cancer growth 

(Ashcraft et al., 2016). Of note, there have been a few exploratory follow-up studies that have 

provided more direct evidence that exercise may improve survival in cancer patients (Courneya 

et al., 2014, 2015). Importantly, the bulk of both the preclinical and clinical evidence has looked 

primarily at these outcomes in breast, colorectal, and prostate cancer and have largely ignored 

the effects of radiation in their analysis. 

As such, there is a need to directly evaluate the combinatory long-term effects of radiation, 

exercise, and/or obesity to reveal their implications in cancer incidence and thus concomitant 

effects on healthspan and survival. Therefore, using an established mouse model of radiation-

induced cancer (Major & Mole, 1978; Rivina et al., 2014, 2016), we aimed to evaluate the effects 

of lifelong treadmill exercise training and HFD-induced obesity on healthspan, cancer incidence, 

and survival following radiation exposure. We hypothesized that sedentary mice with HFD-

induced obesity, will exhibit greater cancer incidence as well as decreased healthspan and 

survival, compared to lean, exercise-trained mice after radiation exposure. Furthermore, we 

predicted that exercise-trained mice with HFD-induced obesity will have greater healthspan and 

survival, as well as decreased cancer incidence compared to sedentary mice with HFD-induced 

obesity, but similar to that in lean, sedentary mice after radiation exposure.  
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Materials and Methods 

Ethical Approval 

Ethical approval for this project was obtained from the University of Ottawa Animal Care and 

Veterinary Service Committee. 

Study Design  

Male CBA mice (n=80) were purchased from The Jackson Laboratory (Bar Harbor, ME) at 

four weeks of age. Mice were allowed to acclimatize to the animal facility for one week, and 

provided food and water ad libitum, maintained on a 12-hour light: dark cycle, and housed under 

specific pathogen free conditions for the duration of the study. Male CBA mice are the favoured 

model of radiation-induced AML (Rivina et al., 2016) because it is the primary type of radiation-

induced cancer in this strain, the morphology of the disease in this strain has been reported to 

closely resemble that in humans (Rithidech et al., 1999), and this strain exhibits a low 

spontaneous AML frequency (less than 1%) (Rivina et al., 2016). 

At five weeks of age, the mice were randomly divided into either a control diet group (CTRL, 

n=40) or high fat diet group (HFD, n=40) and housed at no more than four mice per cage. At nine 

weeks of age, each dietary group was divided in half and randomly assigned to either an exercise 

training intervention (EX) or sedentary (SED) group, making the following 4 groups: CTRL/EX, 

CTRL/SED, HFD/EX, HFD/SED (n=20/group) (Figure 1A). 

Dietary Intervention 

The HFD group was fed a diet consisting of 45% kcal from fat (D12451, Research Diet 

Inc.) and the CTRL group was fed an AIN-93M diet (D10012M, Research Diet Inc.) consisting of 

9.4% kcal from fat with matched micronutrient content to the HFD. Body weight and food intake 

(in grams and kcal) were measured weekly while body fat percentage and lean mass were 

measured monthly using an EchoMRI-900 (EchoMRI LLC, Texas, United States). This dietary 

intervention continued until endpoint.  
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Exercise Intervention 

At nine weeks of age, mice began a treadmill exercise intervention (Exer6; Columbus 

Instruments, Columbus, OH) or remained sedentary as previously described by our group (Baker 

et al., 2011; De Lisio et al., 2011, 2013; De Lisio & Parise, 2012; Emmons et al., 2019). Mice were 

exercise-trained at approximately the same time each day for 3 days/week (Monday, Wednesday, 

Friday) for 1 hour per day up until 14 months of age, at which point their exercise frequency was 

reduced to 2x/week. Each session began with a 10-minute warm-up period at 10 m/min, followed 

by a 45-minute training period starting at 10 m/min and increasing by 1 m/min every 3 training 

sessions up to a maximum of 24 m/min. Mice were encouraged to run by gentle tapping with the 

bristles of a paintbrush. Electric shock was not used. Sedentary mice were placed in a sham 

treadmill with similar dimensions to that of the motorized treadmill. The sham treadmill was placed 

on top of the actual treadmill for the duration of the exercise training session to control for any 

stress associated with treadmill exercise. This exercise intervention continued until endpoint. 

Radiation Challenge  

At age 13 weeks, all mice were exposed to a single 3 Gy dose of total body gamma radiation 

over 4.32 minutes using an XRAD 320 radiation unit (Precision X-Ray Inc., East Haven, CT). This 

radiation dose administered at this age is sublethal and has been shown to induce AML in ~25% 

of male CBA mice by 18 months after radiation exposure (Major & Mole, 1978). Mice were 

irradiated in a small container to prevent them from moving (non-anesthetized) during radiation. 

The container was then placed in the radiation unit and a uniform dose of radiation was 

administered with the field of the beam being larger than the container to ensure that all mice 

received the same dose. Following radiation exposure, mice were transferred to sterile cages, 

given Baytril water (50 mg/mL) ad libitum for three weeks to prevent infection secondary to 

immunosuppression, and then missed the subsequent exercise-training session. 
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Cancer Incidence  

Primary (bone marrow) and secondary (spleen and liver) sites of hematopoiesis were 

evaluated by a veterinary pathologist blinded to experimental conditions, for AML and other 

microscopic tumours. A positive diagnosis of AML was made based on the established criteria 

outlined in the “Bethesda Proposal for Classification of Nonlymphoid Hematopoietic Neoplasms 

in Mice” (Kogan et al., 2002). Specifically, a positive diagnosis of AML was made if (1) the 

complete blood count (CBC) revealed a low platelet/neutrophil count with or without high white 

blood cell quantity, (2) there was detection of ≥ 20% myeloid blast cells in Wright-Giemsa stained 

hematopoietic tissue, and/or (3) tissue pathology revealed AML infiltration in either the liver or 

spleen. Bi-monthly facial vein blood collection began at 6 months after radiation for CBC analysis 

to begin screening for cancer development and this continued until endpoint. Blood was collected 

in an EDTA-coated microvette capillary tube (Thermo Fisher Scientific, Waltham, MA, 

NC9141704), mixed, and then immediately transferred to a 2 mL Eppendorf tube and stored on 

ice. From each sample, 4 µL of blood was used to prepare each peripheral blood smear which 

were stained in Wright-Giemsa for quantification of blast cells. The remaining blood was used for 

CBC analysis (Centre for Phenogenomics, Toronto, ON). At endpoint, the livers and spleens were 

excised, weighed, visually inspected for macroscopic tumours, and stored in 10% neutral buffered 

formalin. In addition, both femurs were collected and thoroughly cleaned of muscle and other 

connective tissue. Both femurs were fixed in 10% neutral buffered formalin for 48 hours under 

gentle agitation. After fixation, the bones were washed for 1 hour under cool running water and 

then placed in a 14% EDTA decalcification solution for 14 days (Scheller et al., 2014). Once fully 

decalcified, the bones were washed again for 1 hour under cool running water and then stored in 

70% ethanol at 4oC. The samples were then sectioned at a thickness of 4 µm and stained with 

hematoxylin and eosin (H & E) staining for evaluation of blast cell quantity.  
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Endpoint Monitoring 

Health checks were performed on average three to four times per week. Endpoint monitoring 

criteria was created based on previously established guidelines (Burkholder et al., 2012; De Lisio 

et al., 2013; Ullman-Culleré & Foltz, 1999), with minor modifications. Specifically, endpoint criteria 

included: body condition less than three, hunched, ruffled coat, skin lesions, dehydration, lethargy, 

pale mucous membranes, masses, moribund, or a seizure (either lasting longer than 30 seconds 

or more than three seizures in less than one minute). Any abnormalities discovered during a 

health check that were potential grounds for veterinary intervention or euthanasia, were first 

referred to veterinary technicians blinded to experimental groups. 

Behaviour Testing 

Exercise Endurance Test 

Mice underwent endurance testing at baseline, 5 days prior to radiation exposure, 5 days after 

radiation exposure, and 5 months after radiation exposure as previously described (Chorghade 

et al., 2017; De Lisio & Parise, 2012). Prior to starting the test, mice were habituated to the testing 

room for 30 minutes then placed in the treadmill, one mouse per lane. The test began at a speed 

of 11 m/min and increased by 1 m/min every 2 minutes. The bristles of a paint brush were used 

to motivate the mice to continue to run, and electric shock was not used. A mouse was deemed 

to have completed the test if it: (1) was resistant to stimulation, (2) remained on the platform for 

longer than two minutes or, (3) stayed approximately one body length away from the platform for 

longer than five continuous seconds. The speed and time at which each mouse finished the test 

was documented. Analyses were conducted by investigators blinded to experimental group. 

Metabolic Activity 

Oxygen consumption (VO2 and VCO2), heat production, and respiratory exchange ratio 

(RER) were measured using the OXYMAX Comprehensive Lab Animal Monitoring System 

(CLAMS, Columbus Instruments, Columbus, OH). Mice were tested at age 17 months at thermal 
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neutral conditions. Mice were individually housed in CLAMS-specific housing chambers and 

tested for 72 hours. The first 48 hours were used to allow the mice to habituate to the new 

environment and only data collected in the final 24 hours were analyzed. For the entire duration 

of the test, each mouse was provided with water and their specialized diet in powdered form ad 

libitum and maintained on their regular 12-hour light: dark cycle.  

Beam Break (BBK) 

The BBK test was used to assess anxiety-like behaviour (Crawley & Bailey, 2008). Mice were 

tested at age 17 months. Mice were allowed to habituate to the testing room for 30 minutes. They 

were then removed from their original cages and individually housed in new cages placed 

between photocell emitters which sent horizontal beams of infrared light through the cage. Mice 

were monitored for 24 hours to track anxiety-like behaviour throughout their entire circadian cycle. 

BBK data was analyzed using the Fusion 5.3 software for Micromax (Omnitech Electronics, Inc., 

Columbus, OH) by measuring the ambulatory movement, per hour, per each mouse (i.e. number 

of infrared beams broken during ambulation).  

Forelimb Grip Strength 

The forelimb grip strength test was used to measure the maximal grip strength (Pincu et al., 

2016; Zou et al., 2015). Mice were tested at 17 months of age using the Chantillion DFE II 

(Columbus Instruments, Columbus, OH). Prior to testing, mice were allowed to habituate to the 

testing room for 30 minutes. Mice were then placed, one at a time, on the force gauge grid until 

they grabbed it with their front paws. Each mouse was then gently pulled horizontally off the grid 

with a constant and consistent speed. The test was performed by the same experimenter blinded 

to the experimental groups for each mouse to reduce variability. This protocol was repeated for a 

total of 8 trials per mouse and then the grip strength was averaged after removing the highest and 

lowest measurement and normalized to body weight. 
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Tail Suspension 

The tail suspension test is a commonly used test to assess depression-like behaviour in 

rodents (Cryan et al., 2005; Steru et al., 1985; Vagena et al., 2019). Mice were tested at age 17 

months. Prior to testing, mice were allowed to habituate to the testing room for 30 minutes. Mice 

were taped upside down by their tail to a bar connected to a strain gauge. The total test duration 

was 6 minutes with immobility time measured as the total amount of time (in seconds) that a 

mouse spent below the pre-set lower threshold. 

Lipoprotein Levels 

At 17 months of age, plasma was collected from the mice to analyze the high-density to low-

density lipoprotein ratio (HDL:LDL), which is often used to assess cardiovascular disease risk 

(Millán et al., 2009). The mice were not fasted. Blood was collected in an EDTA-coated microvette 

capillary tube (Thermo Fisher Scientific, Waltham, MA, NC9141704), mixed, and then transferred 

into a 2 mL Eppendorf tube which was stored on ice. The blood samples were then centrifuged 

at 5000 rcf for 10 minutes at 8oC. Afterwards, the plasma was removed with a pipette and 

transferred to a new 2 mL Eppendorf tube. The samples were then stored at -80oC until they were 

ready to be shipped and analyzed by investigators blinded to the experimental conditions (Centre 

for Phenogenomics, Toronto, ON). Samples were shipped on dry ice.  

Data Analysis 

Body weight, body fat percentage, lean mass, food consumption, and endurance exercise 

capacity were assessed using a 3-Factor (exercise x diet x time) Repeated Measures ANOVA. 

Tukey’s post hoc test was used to determine significant differences between means for all 

significant main effects and interactions. Metabolic activity, beam break, grip strength, and tail 

suspension were assessed using a 2-Factor (exercise x diet) ANOVA. Sidak’s post hoc test was 

used to determine significant differences between means for all significant main effects and 

interactions.  
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The healthspan index table was adapted from Schafer et al. (2019). It is composed of 10 

different parameters including 4 metabolic, 2 performance, 2 behavioural, and 2 morbidity 

outcomes. A score ranging from -1 to +1 was assigned to each group based on the p-value as 

determined by 2-Factor ANOVA for the anthropometric/metabolic, performance, and behavioural 

outcomes, or Fisher’s Exact test for the morbidity outcome. For outcomes analyzed by 2-Way 

ANOVA, Dunnett’s post hoc test was used to determine significant differences between means 

relative to the CTRL/SED group.  Positive outcomes were assigned positive values and negative 

outcomes were assigned negative values. Specifically, when compared to the CTRL/SED group, 

a p-value greater than 0.10 was given a score of 0, a p-value between 0.05 and 0.10 was given 

a score of ±0.5, and a p-value less than 0.05 was given a score of ±1. The cumulative healthspan 

index was then determined by adding the scores for each outcome together for each group.  

Cancer incidence was determined as the number of new cancer cases over the number of 

mice that were at risk of developing radiation-induced cancer. Mice that died and whose tissue 

was unable to undergo histological analysis (i.e. tissue autolysis as a result of being found dead 

after a prolonged period of time), were removed from this calculation. As such, one mouse from 

the CTRL/SED group, two mice from the CTRL/EX group, one mouse from the HFD/SED group, 

and three mice from the HFD/EX group were excluded as their tissue was unable to be analyzed 

histologically to confirm whether or not they were tumour positive. An additional mouse from the 

HFD/EX group was excluded as it died prior to being exposed to radiation. For seizure burden 

analysis, nine mice from the CTRL/SED group and four mice each from the CTRL/EX group, 

HFD/SED group, and HFD/EX group were excluded as their causes of death were not related to 

either seizures or cancer in the different tissues that were analyzed. Data are presented as mean 

± SEM with a p-value less than 0.05 considered to be statistically significant. All statistical 

analyses above were conducted with GraphPad Prism 8.0 software (Graphpad Software, San 

Diego, CA). 
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Kaplan-Meier survival curves were created for each group to assess overall survival. The log-

rank test was conducted to determine significant differences between curves. Cumulative 

incidence and incidence rate of cancer-related mortality curves were created for each group to 

determine the incidence and rates of cancer development at different points throughout the study. 

Cumulative incidence of cancer-related mortality was calculated as the number of mice that died 

from cancer over the number of mice at risk of dying from cancer at a given timepoint. The 

incidence rate of cancer-related mortality was calculated as the number of cancer cases divided 

by follow time broken up into three-month intervals, measured in mouse-months (m-m). The 

average incidence rate was also calculated for each group across the entire study and then used 

to determine the incidence rate ratios for each group relative to the CTRL/SED group. One mouse 

was removed from the HFD/EX group from all of these analyses except overall survival as it died 

prior to being exposed to radiation. Relative risk was calculated by dividing the cancer incidence 

of each group by that of the CTRL/SED group. Analysis of survival and cumulative incidence of 

cancer-related mortality was conducted using Graphpad Prism 8.0 software (Graphpad Software, 

San Diego, CA). Incidence rates at three-month intervals were calculated using Microsoft Excel 

(Microsoft Corporation, Redmond, WA). Lastly, incidence rate ratios, relative risks, and their 

respective 95% confidence intervals (95% CI) were determined using the epi.2by2 package in 

RStudio (RStudio Computer Program, Boston, MA). 
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Results 

Lifelong exercise and HFD-induced obesity differentially influenced body composition 

throughout the lifespan after radiation exposure. 

Body weight was significantly increased in both HFD groups compared to the CTRL/EX group 

from 2-13 months of age and compared to the CTRL/SED group from 2-7 months, as well as at 

9 and 11 months of age. There was also a significant increase in body weight in the HFD/SED 

group compared to the CTRL/SED group at 8, 10, and 12 months of age and compared to the 

CTRL/EX group at 13 months of age (p<0.05, Figure 1B). Body fat percentage was significantly 

increased in both HFD groups compared to the CTRL/EX group from 2-10 months of age and 

compared to the CTRL/SED group at 2, 3, and 5 months of age. There was also a significant 

increase in body fat percentage in the HFD/SED group compared to the CTRL/SED group at 4 

months of age, as well as between the HFD/EX and CTRL/SED at 6 and 8 months of age (p<0.05, 

Figure 1C). Absolute lean mass was significantly increased in both HFD groups compared the 

CTRL/EX group at 3-8, and at 15 months of age, as well as compared to the CTRL/SED group at 

3, and 5-8 months of age. There was also a significant increase in lean mass in the HFD/SED 

group compared to the CTRL/SED and the CTRL/EX groups at 4 and 11 months, respectively 

(p<0.05, Figure 1D). Food consumption measured per gram and per mouse was significantly 

increased in the HFD/SED and HFD/EX groups at 4 months of age compared to the CTRL/EX 

group and at 1, 4, and 8 months of age compared to the CTRL/SED group. Food consumption 

was also significantly increased in the CTRL/EX and HFD/SED groups at 3 months of age 

compared to the CTRL/SED group (p<0.05, Figure 1E). Caloric intake was significantly increased 

in the HFD/SED and HFD/EX groups at 1 and 3-11 months of age compared to the CTRL/SED 

group, and from 3-5 and 7-9 months of age compared to the CTRL/EX group. Caloric intake was 

also significantly increased in the HFD/EX group at 3 and 12 months of age compared to the 

CTRL/SED group, in the HFD/EX group at 6 months of age compared to the CTRL/EX group, and 

in the HFD/SED group at 10 and 11 months of age compared to the CTRL/EX group (p<0.05, 
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Figure 1F). Data after 16 months are not shown as there were not enough mice per group for 

sufficient statistical power. 

HFD-induced obesity alters substrate utilization with no effect of exercise after radiation 

exposure. 

Figure 2 (A-D) shows the average measure of RER, VO2, VCO2, and energy expenditure 

over one 12-hour light (white bar) and one 12-hour dark cycle (black bar). Figure 2 (E-G) shows 

the average measure of RER, VO2, VCO2, and energy expenditure per hour within an entire light 

and dark cycle. There was a significant decrease in RER in the HFD groups compared to the 

CTRL groups in the light and dark cycle, irrespective of exercise (both p<0.0001). There was no 

significant difference between groups during either the light or dark cycle for VO2, VCO2, and 

direct energy expenditure (p>0.05).   

Lifelong exercise and HFD-induced obesity differentially influenced performance and 

behavioural healthspan outcomes after radiation exposure. 

There was a significant increase in endurance performance in the CTRL/EX group compared 

to both SED groups 5 days pre- and 5 months post-radiation exposure, as well as between the 

HFD/EX group and the HFD/SED group at 5 days pre-radiation exposure (p<0.05, Figure 3A). 

Grip strength normalized to body weight was significantly reduced in the HFD mice compared to 

the CTRL mice regardless of exercise (p<0.05, Figure 3B). The beam break test revealed a trend 

towards decreased anxiety-like behaviour in the CTRL/EX group compared the CTRL/SED group 

during the light (p=0.06) and dark (p=0.108) cycles. Furthermore, there was a significant decrease 

in depression-like behaviour as assessed by the tail suspension test, in the HFD and EX mice 

compared to the CTRL and SED mice, respectively (p<0.05, main effects of diet and exercise). 
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HFD-induced obesity decreased overall healthspan index which was higher in lifelong 

exercise mice after radiation exposure. 

A healthspan index was used to quantify overall healthspan benefits or detriments in each 

group relative to the CTRL/SED group (Table 1) (Schafer et al., 2019). The greatest benefit in 

anthropometric/metabolic outcomes were seen in the CTRL/EX group (score = 1), with no 

changes seen in the HFD/EX and HFD/SED groups (both score = 0). The CTRL/EX group also 

had the highest score for performance outcomes (score = 1), with no changes in the HFD/EX and 

HFD/SED groups (both scores = 0). For the behaviour outcomes, the HFD/EX group had the 

greatest improvement (score = 1) followed by the CTRL/EX group (score = 0.5) and then the 

HFD/SED group (score = 0). Lastly, the HFD/SED group had a slight detriment to morbidity (score 

= -0.5), but there were no changes in the CTRL/EX and HFD/EX group (both scores = 0). 

Cumulatively, the CTRL/EX group had the highest overall healthspan index (score = 2.5), followed 

by HFD/EX group (score = 1), and then the HFD/SED group (score = -0.5). 

HFD-induced obesity and a sedentary lifestyle increased cancer incidence but was 

attenuated by lifelong exercise after radiation exposure. 

Cancer incidence (Figure 4E) was significantly increased in the HFD/SED group (16/19), 

compared to the CTRL/EX group (9/18) (p<0.05). There was also a trend towards a significant 

increase in cancer incidence in the HFD/SED group compared to the CTRL/SED group (10/19; 

p=0.079) but no significant difference between the HFD/SED group compared to the HFD/EX 

group (10/16; p=0.245).  

Lifelong exercise did not reduce all-cause mortality but reduced cancer-related mortality 

risk relative to mice with HFD-induced obesity after radiation exposure. 

 All-cause mortality was significantly decreased in the HFD/SED group compared to the 

CTRL/SED group with no effect of exercise (p<0.05, Figure 5A). There was no significant 

difference in the cumulative incidence (Figure 5B) or average incidence rate (Figure 5C) of 
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cancer-related mortality for each group (p>0.05). Risk of cancer-related mortality after radiation 

exposure, however, was significantly increased in the  HFD/SED group compared to the 

CTRL/SED group (RR=1.60; 95% CI, 1.00-2.56; p=0.0495) (Table 3) and compared to the 

CTRL/EX group (RR=1.68; 95% CI, 1.02-2.78; p=0.0415) (Table 3). There was no significant 

difference in risk of cancer-related mortality in the HFD/SED group compared to the HFD/EX 

group (RR=1.35; 95% CI, 0.88-2.06, p=0.1707) (Table 3). 

Discussion 

Our overall objective was to evaluate the effects of lifelong exercise and HFD-induced obesity 

on healthspan, cancer incidence, and survival in a mouse model of radiation-induced cancer. Our 

results demonstrate that lifelong exercise improved overall healthspan as well as decreased 

cancer incidence (Figure 4E) and relative risk of cancer-related mortality. Importantly, our results 

also demonstrate that the majority of these outcomes were improved in exercise-trained mice but 

made worse in mice with HFD-induced obesity, when compared to the CTRL/SED group. Taken 

together, these data extend our previous findings indicating that exercise attenuated, and HFD-

induced obesity exacerbated the short-term deleterious effects of radiation. In addition, these data 

suggest that exercise and dietary interventions may modulate secondary cancer risk in the rapidly 

growing population of cancer survivors. 

Exercise training has been shown to enhance numerous components of quality of life, physical 

function, and behavioural outcomes for both patients with cancer and cancer survivors (Campbell 

et al., 2019; Dennett et al., 2016; Hilfiker et al., 2018; LaVoy et al., 2016; Schwartz et al., 2017). 

However, there is a lack of evidence examining the persistence of these factors across the 

lifespan. Our results are comparable with work using non-irradiated mice (Nilsson et al., 2019; 

Schafer et al., 2019), in that the greatest improvement in healthspan was seen in exercise-trained 

mice. We extend previous findings by demonstrating that after being exposed to radiation, the 

exercise-induced improvements persist across the lifespan, especially when adipose mass is 

maintained at relatively normal levels. Another important factor to consider is that these various 
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aspects of healthspan deteriorate with age but can be attenuated by exercise in both human 

(Garatachea et al., 2015; Langhammer et al., 2018) and murine populations (Nilsson et al., 2019; 

Schafer et al., 2019). The majority of our healthspan assessments were completed when the mice 

were 17 months of age, which would be roughly equivalent to humans in late adulthood. Given 

that the majority of cancer survivors will be over the age of 60 within the next 20 years (Shapiro, 

2018), our results offer valuable insight into the use of lifelong exercise interventions as a means 

to improve physical and psychological well-being among this population. These findings are 

particularly relevant as cancer survivors tend to score lower in physical and mental health related 

quality of life measures compared to non-cancer survivors (Weaver et al., 2012). Taken together, 

these data suggest that exercise across the lifespan may extend the healthspan of cancer 

survivors. 

Apart from improved healthspan, we also saw a significant increase in cancer incidence in the 

HFD/SED group compared to the CTRL/EX group, with a variety of cancer types identified. The 

model used in this study is the gold standard to investigate radiation-induced AML in rodents 

(Rivina et al., 2016). This is because it has a low spontaneous tumour rate (<1%) and a 3 Gy 

dose of ionizing radiation has been shown to induce AML in 25% of mice by 18 months after 

radiation that mimics the genetic and phenotypic characteristics of human AML (Rivina et al., 

2014, 2016). Given that AML is the most common radiation induced cancer, it was expected that 

it would have been the predominant cancer observed in our mice; however, it was only confirmed 

in two HFD/SED mice at 16- and 18-months after radiation exposure. The most prevalent cancer 

detected in all four experimental groups was liver cancer; specifically hepatocellular adenoma 

which is a benign tumour that has been well documented in older mice belonging to the CBA 

strain (Strong & Smith, 1936). Despite this, we show that the incidence of this tumour is largely 

reduced in exercise-trained mice and those without HFD-induced obesity. Moreover, histological 

analysis revealed that these tumours lead to gross hepatic damage and were the probable cause 

of death. As a result, these tumours were still considered in the cancer incidence and cancer-
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related mortality analyses. Radiation-induced hepatic cancers are not well documented but 

radiation therapy has been shown to increase liver disease which in turn can increase liver cancer 

risk (Kim & Jung, 2017).  

 A recent systematic review indicated a 28-44% reduction in risk of cancer-related mortality 

after cancer diagnosis among those who exercised compared to those who did not (Cormie et al., 

2017). Interestingly, this effect was found almost exclusively in studies that looked at patients with 

either breast, colorectal, or prostate cancer (Cormie et al., 2017). There was also no evidence of 

any study showing that exercise reduced cancer-related mortality among those with 

hematological cancers and more importantly, the study did not consider treatment regimen in their 

analysis (Cormie et al., 2017). Therefore, our data provides novel insight suggesting that lifelong 

exercise training can reduce the risk of cancer-related mortality following radiation exposure 

compared to sedentary counterparts with HFD-induced obesity. Despite reduced cancer 

incidence and risk of cancer-related mortality, we saw no exercise effects in terms of overall 

survival. This appears to be consistent among the limited clinical studies evaluating the effects of 

exercise on survival in cancer. For instance, there was no significant difference in overall survival 

or disease-free survival among patients with breast cancer who exercised during chemotherapy 

treatment compared to those who did not exercise. There was, however, a greater trend towards 

an exercise effect in disease-free survival compared to overall survival in that study (Courneya et 

al., 2014). Together, these findings suggest that exercise may have a more potent effect on 

disease-free survival rather than on overall survival in the context of cancer. As such, a lack of an 

exercise effect on overall survival in this study is not necessarily surprising.  

Apart from the main outcomes of this study, it is worth noting an interesting trend in the 

incidence rates of cancer-related mortality presented in Figure 5C. While not statistically 

significant compared to the other groups, the drastic increase in incidence rate between 15 and 

18 months after radiation in the HFD/SED group is certainly meaningful. For instance, it is 5.8-

fold greater than the incidence rate of the CTRL/EX group and 2.9-fold greater than the HFD/EX 
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group. The incidence rates are expressed as the proportion of new cancer cases over the amount 

of follow-time (100 mouse-months). This would mean if we followed 100 mice per group for 1 

month, the number of mice with cancer in the HFD/SED group would be 5.8- and 2.9-times greater 

than the number of mice with cancer in the CTRL/EX and HFD/EX group, respectively. This 

therefore suggests that the incidence rate of cancer-related mortality induced by HFD-induced 

obesity at late timepoints after radiation exposure, can perhaps be attenuated by exercise-training 

adopted earlier on after radiation exposure. Interestingly, work from our group has shown a similar 

exercise effect in a model of colorectal cancer, where mice who previously had HFD-induced 

obesity and then exercise-trained for 22 weeks, showed decreased CRC incidence compared to 

mice who continued to have HFD-induced obesity (Emmons et al., 2019). Taken together, this 

finding suggests that at late timepoints after radiation exposure, HFD-induced obesity 

exacerbates the incidence rate of cancer-related mortality, which could potentially be attenuated 

with exercise training. As such, it would be interesting for future studies to explore the effects of 

introducing exercise-training to mice with HFD-induced obesity after radiation exposure. 

In conclusion, it has been well established that exercise alone can have a positive effect on 

hematopoiesis, whereas both radiation and obesity can individually be detrimental to 

hematopoiesis. In addition, our previous work showed that at an acute time point after radiation 

exposure, exercise training mitigated some of the deleterious effects of radiation and obesity on 

hematopoiesis. Our present study extends previous work by showing that lifelong exercise 

training improved healthspan, decreased cancer incidence, and risk of cancer-related mortality in 

a mouse model of radiation-induced cancer. Importantly, we also show these effects are largely 

opposed among mice with HFD-induced obesity that remained sedentary. Given that the number 

of cancer survivors exposed to radiation is increasing, and that there is substantial evidence 

highlighting the increased cancer risk associated with radiation exposure, our findings support the 

need for studies to investigate the long-term effects of radiation, exercise, and obesity in a clinical 

setting of cancer survivors.  
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Figure Captions 

Figure 1. Lifelong exercise and HFD-induced obesity differentially influenced body 

composition throughout the lifespan after radiation exposure. 

A schematic of the experimental timeline (A). Body weight (B), body fat percentage (C) absolute 

lean body mass (D) food intake measured per gram (E) and kilocalories (F) until 16 months of 

age. The dotted grey line represents the age at which mice were radiated. Data are presented as 

mean ± SEM (n=4-20/group/time point). *p<0.05 significant difference between CTRL/SED 

compared with HFD/SED and HFD/EX. βp<0.05 significant difference between CTRL/EX 

compared with HFD/SED and HFD/EX, asignificant difference between CTRL/SED compared with 

HFD/SED, hsignificant difference between CTRL/EX compared with HFD/SED, esignificant 

difference between CTRL/SED compared with HFD/EX, ‡significant difference between CTRL/EX 

compared with HFD/EX, †significant difference between CTRL/SED compared with CTRL/EX and 

HFD/SED. 

Figure 2. HFD-induced obesity alters substrate utilization with no effect of exercise after 

radiation exposure. 

(A) Average respiratory exchange ratio (RER), (B) oxygen consumption (VO2), (C) carbon dioxide 

production (VCO2), and (D) energy expenditure over one 12-hour light (white bar) and one 12-

hour dark cycle (black bar). (E) average RER, (F) VO2, (G) VCO2, and (H) energy expenditure 

during the light and dark cycle. Data are presented as mean ± SEM (n = 3-8/group). #p<0.05 main 

effect of diet. 

Figure 3. Lifelong exercise and HFD-induced obesity differentially influenced performance 

and behavioural healthspan outcomes after radiation exposure. 

(A) Endurance performance for each group at baseline, 5 days pre-IR, 5 days post-IR, and 5 

months post-IR (IR; ionizing radiation). Data are presented as mean ± SEM (n = 17-20/group/time 

point). (B) Forelimb grip strength normalized to body weight, (C) anxiety-like behaviour as 



   
 

 56 

measured by the mean number of beams broken per group over an entire light and dark cycle 

(D), and depression-like activity as measured by time spent immobilized during a six-minute tail 

suspension test. (B-D) were all assessed at 17 months of age. Data are presented as mean ± 

SEM (n = 3-8/group). βp<0.05 significant difference between CTRL/EX compared with HFD/SED 

and HFD/EX, §p<0.05 significant difference between HFD/EX compared with HFD/SED and 

HFD/SED, #p<0.05 main effect of diet, *p<0.05 main effect of exercise. 

Figure 4. HFD-induced obesity and a sedentary lifestyle increased cancer incidence but 

was attenuated by lifelong exercise after radiation exposure. 

Representative images of various tumours identified. (A) Sheets of AML cells in the bone marrow 

(60x), (B) a mass of AML cells (AML) is delineated with black arrowheads from the liver (L) that 

is infiltrated by small clusters of AML cells in the sinusoids (some indicated by full black arrows) 

(20x), (C) hepatocellular adenoma (HepA) is delineated by arrowheads from liver (L) (20x), and 

(D) hepatic adenocarcinoma (HepAc) is delineated by arrowheads from the liver (L) (20x). H&E 

stain. (E) Pie charts highlighting the distribution of various tumour types per group identified 

through histological analysis (n=16-19 per group). *p<0.05 compared to the HFD/SED group. 

Figure 5. Lifelong exercise did not reduce all-cause mortality but reduced cancer-related 

mortality risk relative to mice with HFD-induced obesity after radiation exposure. 

(A) Overall survival across the entire study (n = 20 mice/group). The dotted grey line represents 

the age at which mice were irradiated. (B) The cumulative incidence of cancer-related mortality 

for each group (n = 19-20 mice/group). (C) The cancer-related mortality incidence rate per 100 

mouse-months divided into 3-month intervals across the entire study (n = 19-20 mice/group). In 

(B & C), one mouse from the HFD/EX group was excluded as it died prior to being exposed to 

radiation. Survival was examined by Kaplan-Meier analysis. *p<0.05 CTRL/EX vs. HFD/SED 

group.  
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Figure 2 
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Figure 3 
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Table 1. HFD-induced obesity decreased overall healthspan index which was reversed by lifelong exercise after radiation 
exposure. 

Data for the metabolic, performance and behaviour outcomes are presented as mean ± SEM (n=4-20/group/outcome). Body fat and 
lean mass were measured from the time of radiation exposure (13 weeks) until endpoint. Tumour and seizure burden were assessed 
across the lifespan after radiation exposure. All other outcomes were measured at 17 months of age. Healthspan score was assigned 
based on the p-value as determined by 2-Way ANOVA or Fisher’s Exact test comparing the CTRL/EX, HFD/SED and HFD/EX groups 
to the CTRL/SED group. 

 Outcomes Parameters Summary data: Mean ± SEM or Number (%) p-value aScore (-1 to +1) 

    CTRL/SED CTRL/EX HFD/SED HFD/EX CTRL/EX HFD/SED HFD/EX CTRL/EX HFD/SED HFD/EX 

Anthropometric/ 

Metabolic 

bBody fat (%) 23.9 ± 0.5 20.39 ± 1.0 27.90 ± 0.5 28.13 ± 0.5 0.0007 <0.0001 <0.0001 1 -1 -1 

bLean mass (g) 24.9 ± 0.5 24.9 ± 0.3 28.8 ± 0.4 27.6 ± 0.5 >0.9999 <0.0001 0.0004 0 1 1 

Metabolism 

VO2: 94390 ± 
10637.6 mL 

VO2: 106618 ± 
2311.9 mL 

VO2: 108770 ± 
6149.1 mL 

VO2: 105271 ± 
3638.6 mL 0.4306 0.2499 0.4667 0 0 0 

VCO2: 92015 ± 
12584.6 mL 

VCO2: 103249 ± 
3368.8 mL 

VCO2: 95368 ± 
3894.0 mL 

VCO2: 88416 ± 
3392.9 mL 0.4268 0.9441 0.9366 0 0 0 

Heat: 0.47 ± 0.06  
kcal 

Heat: 0.53 ± 0.01 
kcal 

Heat: 0.55 ± 0.02 
kcal 

Heat: 0.52 ± 0.02 
kcal 0.3421 0.1339 0.4966 0 0 0 

HDL:LDL ratio (A.U.) 16.17 ± 4.4 19.98 ± 4.9 12.6 ± 3.2 18.22 ± 5.2 0.9156 0.9283 0.9816 0 0 0 

Performance 
cEndurance (m/min) 26.3 ± 1.6 37.33 ± 1.6 24.43 ± 1.4 33.0 ± 1.4 <0.0001 >0.9999 0.0064 1 0 1 

Grip Strength/BW (F/g) 4.1 ± 0.3 4.4 ± 0.2 3.7 ± 0.1 3.3 ± 0.2 0.6722 0.3599 0.032 0 0 -1 

Behaviour 
Anxiety (beams broken) 380.8 ± 91.8 552.6 ± 57.7 482.9 ± 26.3 469.1 ± 21.8 0.0612 0.3035 0.4259 0.5 0 0 

Depression (s) 118.9 ± 21.7 101.5 ± 17.7 100.4 ± 15.2 42.94 ± 10.4 0.8185 0.7711 0.0228 0 0 1 

Morbidity 
Tumour burden 10/19 (53%) 9/18 (50%) 16/19 (84%) 10/16 (63%) >0.9999 0.079 0.734 0 -0.5 0 

Seizure burden 2/11 (18%) 7/16 (44%) 1/20 (6%) 2/20 (13%) 0.231 0.549 0.9999 0 0 0 

Total                 2.5 -0.5 1 
aP value: 0 = p>0.1 = 0; ±0.5 = 0.05<p<0.01; ±1 = p<0.05 
b2-Factor ANOVA of average per group from 1st EchoMRI after radiation to endpoint for each mouse; CTRL/EX, HFD/SED, and HFD/EX with CTRL/SED as control. 
c2-Factor ANOVA of average per group after radiation; CTRL/EX, HFD/SED, and HFD/EX with CTRL/SED as control. 
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Figure 4  
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Figure 5 
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Table 2. Exercise-training did not improve the average incidence rate of cancer-related mortality relative to mice with HFD-
induced obesity, after radiation exposure. 

 
Incidence rate was determined per group as the proportion of confirmed cancer cases over the total follow-time contributed by the mice 
at risk in each group. The incidence rate ratio was calculated by diving the incidence rate of each group by the incidence rate of the 
CTRL/SED group. The 95% confidence interval (95% CI) was calculated for each comparison using the epi.2by2 package in RSudio.  
 
 
 
 
 
 
 
 
 
 

 CTRL/SED (n=19) CTRL/EX (n=18) HFD/SED (n=19) HFD/EX (n=16) 

Cases (%) 10 (53) 9 (50) 16 (84) 10 (63) 

Follow time (m-m) 188 205 236 192 

Incidence Rate 
(cases/100 m-m) 5.3 4.4 6.8 5.2 

Incidence Rate Ratio 
(95% CI) --- 0.83 (0.30-2.26) 1.27 (0.54-3.14) 0.98 (0.37-2.62) 
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Table 3. After radiation exposure, HFD-induced obesity increased the relative risk of cancer-related mortality compared to 
mice without HFD-induced obesity and those who engaged in lifelong exercise-training. 

 

 
Absolute risk was determined per group as the proportion of confirmed cancer cases over the number of mice at risk per group. Relative 
risk was determined as the proportion of the absolute risk per group from left to right in the table, over the absolute risk per group from 
top to bottom in the table. The 95% confidence interval (95% CI) was calculated for each comparison using the epi.2by2 package in 
RSudio. Statistically significant results are indicated in bold. 

Absolute risk 

 CTRL/SED (n=19) CTRL/EX (n=18) HFD/SED (n=19) HFD/EX (n=16) 

 0.53 0.50 0.84 0.63 

Relative Risk (95% CI) 

 CTRL/SED (n=19) CTRL/EX (n=18) HFD/SED (n=19) HFD/EX (n=16) 

CTRL/SED 1 0.95 (0.51-1.78) 1.60 (1.00-2.56) 1.19 (0.67-2.10) 

CTRL/EX 1.05 (0.56-1.97) 1 1.68 (1.02-2.78) 1.25 (0.69-2.27) 

HFD/SED 0.62 (0.39-1.00) 0.59 (0.36-0.98) 1 0.74 (0.48-1.14) 

HFD/EX 0.84 (0.48-1.49) 0.80 (0.44-1.45) 1.35 (0.88-2.06) 1 
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Chapter III: Global Discussion 

 
By 2040, the number of cancer survivors in the United States will be close to 24 million, most 

of whom will be 60 years of age or older (Shapiro, 2018), and who would have received radiation 

therapy as part of their treatment (American Cancer Society, 2010). This is problematic as studies 

have shown that the late effects of radiation exposure can lead to the development of secondary 

cancers (Kleinerman et al., 1995; Nguyen & Wu, 2011), of which AML is most common 

(Richardson et al., 2009). Addressing the radiation delivery side of therapy, however, is just one 

factor in addressing the challenges facing this rapidly growing cancer survivor population. For 

instance, among this population, there are also increases in obesity and physical inactivity, both 

of which have been linked to increased cancer risk in general (Clague & Bernstein, 2012; 

Renehan et al., 2008), but also AML (Castillo et al., 2012). Moreover, psychological and physical 

well-being are reported to be lower among cancer survivors than non-cancer survivors (Weaver 

et al., 2012). Unfortunately, with a decrease in healthspan and increased risk of secondary cancer 

development, it can be expected that cancer survivors will have an increased risk of mortality. It 

is therefore imperative to develop strategies such as exercise training to potentially mitigate the 

late effects that radiation and obesity can have on healthspan, cancer incidence, and lifespan. 

This in turn, would provide valuable new insights into cancer treatment and lifestyle modifications 

to improve healthspan, decrease secondary cancer incidence, and promote longevity among 

cancer survivors exposed to radiation during treatment (Figure 6). 

Until recently, literature exploring the combinatory effects of radiation, exercise, and obesity 

had not been studied. In the recent work from our lab, analysis of the cellular and proteomic 

changes in the bone marrow at an acute timepoint after radiation exposure suggested that obesity 

negatively affected hematopoiesis, with exercise having the opposite effect (Emmons et al., 

2019). Moreover, bone marrow supernatant extracted from irradiated mice with obesity increased 

leukemic cell viability in vitro compared to irradiated mice without obesity (Emmons et al., 2019). 
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This provided promising evidence to support exercise as a strategy to mitigate the long-term 

effects of radiation, specifically in reducing cancer incidence and improving survival in vivo, which 

was the aim of the present study. Using an established model of radiation induced cancer (Rivina 

et al., 2016), our results demonstrate that CTRL/EX mice had the greatest improvements in 

healthspan compared to all other groups, as well as significantly lower cancer incidence and risk 

of cancer-related mortality compared to the HFD/SED group. Taken together, our findings are the 

first to show that lifelong exercise was able to improve healthspan, decrease cancer incidence, 

and ultimately decrease the risk of cancer-related mortality in a mouse model of radiation-induced 

cancer. While this study analyzed more global outcomes, the following discussion will explore 

potential cellular and molecular targets that may explain some of these findings and guide future 

work in this field. 

With respect to healthspan, we found that the CTRL/EX mice had greater improvements than 

the HFD/EX and HFD/SED groups when normalized to the CTRL/SED group. The overall 

healthspan score was composed of metabolic, behaviour, performance, and morbidity outcomes. 

The majority of these findings align with the existing literature showing that exercise can improve 

several aspects of healthspan in both human (Burke et al., 2017; Campbell et al., 2019) and 

murine populations (Nilsson et al., 2019; Schafer et al., 2019). With that said, it was surprising to 

see that mice fed a HFD had significantly decreased depression-like behaviour compared to those 

fed a CTRL diet (p<0.05), given that numerous studies suggest a positive correlation between 

obesity and depression in humans (Faith et al., 2002; Luppino et al., 2010; Mulugeta et al., 2018). 

Among laboratory mice, however, the findings are controversial as some studies using both diet-

induced and genetic models of obesity have shown increased depression-like behaviour (Vagena 

et al., 2019), while other studies using similar models have shown reduced depression-like 

behaviour (Del Rosario et al., 2012; Finger et al., 2011; Karth et al., 2019). One reason for this 

discrepancy could be due to the testing modality used to assess depression-like behaviour (Bai 

et al., 2001; Cryan et al., 2005). Another reason could be that none of these studies tested mice 
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at nearly the same age as those tested in our current study, nor did they include radiation as a 

confounder. There is extremely limited evidence examining the link between radiation exposure 

and depression-like behaviour, although one study did show that mice who received increasing 

doses of radiation to the brain (between 0.25-1Gy) had greater depression-like behaviour in a tail 

suspension test compared to non-irradiated controls (Dos Santos et al., 2018). Therefore, the 

novel results seen in our study may suggest that the HFD offered a greater anti-depressive effect 

compared to CTRL-diet fed mice following whole body radiation. With that said, depression was 

just one of several components used to assess healthspan in this study, rather than the sole focus 

of this study. Therefore, the use of the tail suspension was sufficient to assess depression in our 

mice as the analysis into the molecular changes in the brain are beyond the scope of this study. 

Future studies, with depression as their primary outcome, however, should use the tail suspension 

test in combination with the analysis of anti-depressive markers in the brain such as serotonin 

and/or brain-derived neurotrophic factor (Martinowich & Lu, 2008), in order to gain further insight 

into whether diet reduces depression-like behaviour in irradiated mice. 

With regards to cancer incidence, our study showed that the HFD/SED group had the highest 

cancer incidence compared to all other groups. Notably, the most common group of cancers 

identified in our mice were adenomas, not leukemias. Early work on the CBA strain showed that 

adenomas are common (Strong & Smith, 1936), although there is a lack of evidence analyzing 

the effect of radiation on liver cancer incidence in this strain. The low incidence of AML in this 

study, with it only identified in two mice in the HFD/SED group, was still surprising given that it is 

the most common radiation-induced cancer. Some possible reasons for this can be found in work 

from our group’s previous study. Specifically, proteomics analysis revealed that one month after 

radiation exposure, exercise-trained mice had increased pro-hematopoietic factors (i.e. M-CSF, 

MIP-2a and CXCL12), decreased expression of pro-inflammatory cytokines (i.e. TNFa and IL-

1b), and increased expression of cytokines that inhibit AML viability (i.e. IGFBP-3), compared to 
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mice who were sedentary and fed a HFD (Emmons, Ngu, et al., 2019). In addition, we also found 

that hematopoietic stem and progenitor cells (HSPCs) in exercise-trained mice experienced less 

oxidative stress compared to sedentary mice which could result in a decreased likelihood of these 

cells becoming oncogenic (Emmons, Ngu, et al., 2019). While these data provide some insight 

into some of the HSC-intrinsic changes that may contribute to the decreased cancer incidence 

with exercise-training observed in our study, they have yet to be evaluated long-term after 

radiation exposure and therefore, should be the focus of future research.  

Importantly, our previous study also highlighted important changes that occurred in non-

hematopoietic cells which could provide more explanations for the results found in our study 

(Emmons et al., 2019). Specifically, we previously showed that exercise-trained mice had an 

increase in endothelial progenitors and MSCs compared to the mice who remained sedentary. 

Maintenance of these cell types in the HSC niche is vital for steady state hematopoiesis and in 

the context of AML. Both radiation and AML have been shown to be damaging to the vessels 

within the HSC niche (Cao et al., 2011; Duarte et al., 2018). This is problematic given that 

endothelial cells play vital roles in HSC proliferation and differentiation, release CXCL12 and SCF 

to improve HSC maintenance, and can even decrease reactive oxygen species in different 

regions on the niche (Asada et al., 2017; Ding et al., 2012). Notably, increasing the number of 

vessels that supply the HSC niche has been shown to decrease the number of AML cells and 

increase survival in mice following chemotherapy (Duarte et al., 2018). Taken together, this 

suggests that preserving or increasing the vasculature in the HSC niche may be a mechanism 

through which AML incidence is attenuated. Therefore, future work should explore the long-term 

vasculature responses to lifelong exercise, obesity, and radiation exposure in the bone marrow. 

MSCs on the other hand have been suggested to be relatively radiation-resistant (Singh et 

al., 2012; Sugrue et al., 2013), up until recently where a study showed that this was only the case 

for a few MSC subsets (Severe et al., 2019). LepR+-MSCs are one of the various subtypes of 

MSCs that regulate hematopoiesis by being sources of CXCL12 and SCF, and have been shown 
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to be depleted after radiation exposure (Severe et al., 2019). Radiation-induced depletion of 

LepR+-MSCs may be due to enhanced adipogenic differentiation (Zhou et al., 2017). These 

LepR+-MSC-derived adipocytes then become important sources of SCF and aid in HSC recovery 

after injury (Zhou et al., 2017). It has also been suggested that this acute increase in MAT can 

decrease AML burden in mice with active AML (Boyd et al., 2017). Unfortunately, as would be the 

case among cancer survivors, the long-term accumulation of MAT in a disease-free context can 

have detrimental effects on HSCs long-term (Naveiras et al., 2009), and support AML recurrence 

by causing myeloid skewing (Patel et al., 2018). Notably, however, exercise has been shown to 

decrease MAT and increase osteoblast number (Baker et al., 2011), even after radiation exposure 

(Emmons, Ngu, et al., 2019). This suggests that LepR+-MSCs and their progeny may play an 

important role in AML suppression or development, respectively. As such, future work should 

explore the long-term changes to LepR+-MSCs, MAT, and osteoblasts in the HSC niche in 

combination with lifelong exercise, obesity, and radiation exposure. 

Ultimately, with improvements in healthspan and lower cancer incidence in the exercise 

groups, it was expected that these effects would result in improved longevity. Our results 

demonstrate that despite seeing no significant differences in overall survival, mice who were 

exercise-trained had lower risk of cancer-related mortality compared to the HFD/SED group. The 

reason for this is likely multi-factorial, and certainly the reasons presented above and in chapter 

II, likely also contribute to this difference. It is also worth noting that the CBA strain is highly 

susceptible to seizures after 6 months of age and this contributed to 15% of the total deaths in 

this study (see Table 1). Another important factor to consider is that both radiation and a HFD 

produce an aging phenotype at the cellular level. Indeed, sub-lethal radiation doses have been 

shown to induce premature upregulation of senescence markers p16Ink4a and SA-β-gal, which are 

similarly expressed in aged HSC populations (C. Wang et al., 2013, 2015; Y. Wang et al., 2006). 

Moreover, radiation has been shown to downregulate expression of Meis1 which reduces the self-

renewal capacity of HSCs (Unnisa et al., 2012). Lastly, a 3 Gy dose of radiation has been shown 
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to increase HSC divisions by nearly 10 times more than HSCs not exposed to radiation, increasing 

the risk of early senescence (Ban & Kai, 2009). A HFD on the other hand, through its induction of 

myeloid skewing, prematurely exhausts the pool of the more quiescent HSCs and is characteristic 

of aging HSCs (Lee et al., 2018; Rimmelé et al., 2014; Van Den Berg et al., 2016). Furthermore, 

a HFD has been shown to increase pro-inflammatory cytokines which in turn leads to greater 

oxidative stress and DNA damage in HSCs (Emmons, Xu, et al., 2019; Mangialardi et al., 2014). 

This suggests that combined with radiation, a HFD prematurely induces an aging phenotype that 

can inevitably result in increased cancer risk and therefore increased risk of cancer-related 

mortality. Importantly, most of these factors have been shown to be reduced with exercise, 

highlighting possible explanations for the decreased risk of cancer-related mortality compared to 

the HFD/SED group (Nilsson et al., 2019; Rebelo-Marques et al., 2018). Therefore, investigation 

into these targets in lifelong exercise-trained mice with and without HFD-induced obesity after 

radiation exposure is warranted. 

Apart from the main outcomes in this study, it is worth discussing some of the statistical 

methods used in this study especially with regards to cancer incidence and cancer-related 

mortality. As mentioned in Chapter II, cancer incidence is the amount of new cancer cases over 

the number of mice who were at risk (i.e. exposed to radiation). In this study we show this in two 

ways. The first is by determining the incidence over the entire 18-month timeframe (Figure 4E) 

and the second was by determining the cumulative incidence (Figure 5B) which shows the cancer 

incidence at various timepoints throughout the study. The first method is beneficial because it is 

less impacted by competing events (i.e. mice dying from other causes besides cancer). The 

second method, however, is more sensitive to competing events. It is based on survival analysis 

which allows for censoring of mice that died due to competing events. Censoring does not cause 

any change to the curve, but it does decrease the number of mice that are at risk of developing 

cancer in the next month. Therefore, the more mice there are that are censored, especially early 

on, the more variable the end of these curves become, typically resulting in an overestimation of 
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incidence. Furthermore, in survival analysis, one of the key assumptions is that the risk reduction 

does not change with time. While typically the log-rank test is not overly affected by slight 

deviations in this assumption, a clear violation is when curves cross which increases the likelihood 

of developing a type II error (Bouliotis & Billingham, 2011). With that said, the curve still provides 

valuable insight into how incidence changes at different times throughout the study. It does not, 

however, indicate the rate at which these cancer-related deaths occur (also known as incidence 

rates). Information about incidence rates is particularly important because it provides a way to 

most appropriately deal with competing events. Incidence rates provide information about the 

number of new cases over the number of mice that were at risk and for how long they were at risk 

for. Even if a mouse died from competing events, the duration of time it was at risk for is 

incorporated into the data rather than being censored. As such, by providing all three methods, 

this study provides a more comprehensive view into the effects of radiation, HFD-induced obesity 

and exercise-training on cancer incidence and cancer-related mortality overall and at different 

timepoints in the study. 

Strengths 

This study presented various strengths that allowed for a more accurate interpretation of the 

data and better guide future work in the field in both pre-clinical and clinical settings. This study 

used the gold-standard murine model of radiation-induced cancer with a pathology of AML that 

closely resembles that in humans, and a low spontaneous AML rate (Rivina et al., 2016). 

Moreover, the number of potential biases were carefully considered and eliminated to the best of 

our ability. For instance, all histological samples were analyzed by a trained veterinary pathologist 

blinded to the experimental conditions. CBC and lipoprotein analyses were also conducted by 

investigators blinded to the experimental conditions. During health checks, while carried out by 

the primary researchers involved in this study, all decisions made around implementing 

treatments or euthanasia required secondary confirmation by veterinary technicians or 

veterinarians who were also blinded to the experimental conditions. With regards to the exercise 
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program implemented, it was designed to closely resemble the recent guidelines established for 

the cancer survivor population (Campbell et al., 2019). Lastly, the 45% HFD used also closely 

mimics the composition of a western diet and has been shown to exhibit various hallmarks of 

metabolic syndrome and obesity, such as elevated HbA1c and pro-inflammatory cytokines 

(Emmons et al., 2019).  

Limitations  

Despite the various strengths in the study, it is important to also consider a number of 

limitations when interpreting the data in this study. As is the case with all animal models, clinical 

studies need to be conducted to confirm the translatability of this work to humans. One important 

difference to note is that hematopoietic neoplasms in mice can originate in both the spleen and 

bone marrow, whereas in humans they are mostly found in the bone marrow (Kogan et al., 2002). 

When this is the case, however, typically blast cells are more prominent in the bone marrow. As 

such it is recommended to make the diagnosis of leukemia from bone marrow tissue rather than 

splenic tissue (Kogan et al., 2002). In this study, splenic involvement was only present in three 

cases of lymphoma and both cases of AML (11% of total cancer cases). In addition, as mentioned 

earlier, there is a high incidence of liver cancer and seizures in the CBA strain, which may have 

contributed to earlier mortality and thus, preventing AML development in some of the mice. 

Another limitation to consider is that we did not include a non-irradiated group. While the goal of 

this study was to look at the effects of exercise and/or HFD-induced obesity after radiation 

exposure, and using an animal model that would be most representative of the cancer survivor 

population, we are not able to conclude to what extent the damaging effects of radiation alone 

contributed to these results. Current studies are ongoing in the lab that include this group. 

Taken together, this study is the first to combine several long-term behaviour and disease-

relevant outcomes to directly evaluate how lifelong exercise training and HFD-induced obesity 

can impact healthspan, cancer incidence, and cancer-related mortality in a mouse model of 

radiation-induced cancer (Figure 6). Moving forward, we aim for this work to be foundational in 
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motivating more clinical work to focus on the damaging late effects of radiation among cancer 

survivors and the implementation of exercise and dietary interventions to improve their overall 

health while simultaneously protect against treatment-related cancer. This work also provides 

preclinical support for increased long-term cancer surveillance in cancer survivors with obesity 

who were exposed to radiation therapy.  
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Figure Caption 

Figure 6. The effects of radiation, exercise, obesity or their combination on hematopoiesis, 

healthspan, cancer incidence and cancer-related mortality. 

Exercise alone can have a positive effect (green arrows) on hematopoiesis, whereas both 

radiation and obesity can individually have a negative effect (red dashed arrows). At an acute 

timepoint after radiation, our previous work demonstrated that exercise training appears to 

mitigate some of the deleterious effects of radiation and obesity on hematopoiesis and has been 

suggested to potentially decrease the incidence of radiation-induced cancer. The present work 

expands on these findings by being the first to show that lifelong exercise training improved 

healthspan, decreased cancer incidence, and cancer-related mortality in a mouse model of 

radiation-induced cancer. We also show these effects are largely reversed among mice with HFD-

induced obesity and who remained sedentary. Lastly, this study highlights the need for future 

investigation into the long-term cellular and molecular changes within the bone marrow that could 

account for the results shown in the present study. Created with BioRender.com. 
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APPENDIX A – SUPPLEMENTAL FIGURES AND TABLES 

Figure S1. After radiation exposure, HFD-induced obesity, independent of exercise, 

increased total cholesterol levels but did not increase cardiovascular disease risk 

compared to mice fed a control diet. 

(A) Total cholesterol levels in plasma, (B) HDL:LDL ratio, (C) HDL-cholesterol, and (D) LDL-

cholesterol measured in plasma at 17 months of age. Data are presented as mean ± SEM (n = 3-

8/group). #p<0.05 main effect of diet. 

Figure S2. After radiation exposure, HFD-induced obesity and exercise-training 

differentially influenced absolute and relative liver and spleen weights. 

(A) Absolute liver weight, (B) liver weight normalized to body weight, (C) absolute spleen weight, 

and (D) spleen weight normalized to body weight. Data are presented as mean ± SEM (n = 16-

19/group). #p<0.05 main effect of diet, *P<0.05 main effect of exercise. 
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Figure S1. 
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Figure S2. 
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S Table 1. HFD-induced obesity decreased overall healthspan index which was reversed by lifelong exercise after radiation 
exposure. 

a2-Factor ANOVA of average per group from 1st EchoMRI after radiation to endpoint for each mouse; CTRL/EX, HFD/SED, and HFD/EX with 
CTRL/SED as control. 
b2-Factor ANOVA of average per group after radiation; CTRL/EX, HFD/SED, and HFD/EX with CTRL/SED as control. 
 
Data for the metabolic, performance and behaviour outcomes are presented as mean ± SEM (n=4-20/group/outcome). Body fat and 
lean mass were measured from the time of radiation exposure (13 weeks) until endpoint. Tumour and seizure burden were assessed 
across the lifespan after radiation exposure. All other outcomes were measured at 17 months of age. The effect size and 95% 
confidence interval (95% CI) were calculated comparing the means of the CTRL/EX, HFD/SED and HFD/EX groups to the CTRL/SED 
group. 
  

 Outcomes Parameters Summary data: Mean ± SEM or Number (%) Effect Size  
(95% CI) 

  CTRL/SED CTRL/EX HFD/SED HFD/EX CTRL/EX HFD/SED HFD/EX 

Metabolic 

aBody fat (%) 23.9 ±  0.5 20.39 ± 1.0 27.90 ± 0.5 28.13 ± 0.5 -1.02  
(-1.66, -0.35) 

1.92  
(1.14, 2.62) 

1.99  
(1.19, 2.71) 

aLean mass (g) 24.9 ± 0.5 24.9 ± 0.3 28.8 ± 0.4 27.6 ± 0.5 0.00  
(-0.62, 0.62) 

2.50  
(1.63, 3.28) 

1.55  
(0.81, 2.23) 

Metabolism 

VO2: 94390 ± 
10637.6 mL 

VO2: 106618 ± 
2311.9 mL 

VO2: 108770 ± 
6149.1 mL 

VO2: 105271 ± 
3638.6 mL 

0.85  
(-0.61, 2.11) 

0.77  
(-0.52, 1.95) 

0.75  
(-0.58, 1.94) 

VCO2: 92015 ± 
12584.6 mL 

VCO2: 103249 ± 
3368.8 mL 

VCO2: 95368 ± 
3894.0 mL 

VCO2: 88416 ± 
3392.9 mL 

0.64  
(-0.77, 1.91) 

0.20  
(-1.02, 1.39) 

-0.22  
(-1.43, 1.03) 

Heat: 0.47 ± 0.06  
kcal 

Heat: 0.53 ± 0.01 
kcal 

Heat: 0.55 ± 0.02 
kcal 

Heat: 0.52 ± 0.02 
kcal 

0.80 
 (-0.64, 2.07) 

0.98 
 (-0.35, 2.16) 

0.60  
(-0.70, 1.80) 

HDL:LDL ratio 
(A.U.) 16.17 ± 4.4 19.98 ± 4.9 12.6 ± 3.2 18.22 ± 5.2 0.38  

(-1.11, 1.77) 
-0.49  

(-1.87, 1.02) 
0.17  

(-1.20, 1.50) 

Performance 

bEndurance 
(m/min) 26.3 ± 1.6 37.33 ± 1.6 24.43 ± 1.4 33.0 ± 1.4 1.58  

(0.84, 2.26) 
-0.28 

 (-0.90, 0.35) 
1.03  

(0.34, 1.67) 
Grip Strength/BW 

(F/g) 4.1 ± 0.3 4.4 ± 0.2 3.7 ± 0.1 3.3 ± 0.2 0.59  
(-0.88, 1.93) 

-1.05  
(-2.35, 0.43) 

-1.44  
(-2.76, 0.17) 

Behaviour 
Anxiety (beams 

broken) 380.8 ± 91.8 552.6 ± 57.7 482.9 ± 26.3 469.1 ± 21.8 1.08  
(-0.36, 2.31) 

0.86  
(-0.44, 2.04) 

0.76  
(-0.57, 1.96) 

Depression (s) 118.9 ± 21.7 101.5 ± 17.7 100.4 ± 15.2 42.94 ± 10.4 -0.42 
(-1.77, 1.03) 

-0.44  
(-1.74, 0.93) 

-2.50  
(-3.93, -0.58) 

Morbidity 
Tumour burden 10/19 (53%) 9/18 (50%) 16/19 (84%) 10/16 (63%) - - - 

Seizure burden 2/11 (18%) 7/16 (44%) 1/20 (6%) 2/20 (13%) - - - 
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APPENDIX B - DIET INFORMATION 

D12451 – Rodent Diet with 45 kcal% Fat 

Data obtained from: https://researchdiets.com/formulas/d12451 
 
Formulation: 
 

Class Description Ingredients Grams 
Protein Casein, Lactic, 30 Mesh 200.00 g 
Protein Cystine, L 3.00 g 
Carbohydrate Sucrose, Fine Granulated 176.80 g 
Carbohydrate Lodex 10 100.00 g 
Carbohydrate Starch, Corn 72.80 g 
Fiber Solka Floc, FCC200 50.00 g 
Fat Lard 177.50 g 
Fat Soybean Oil, USP 25.00 g 
Mineral S10026B (RD-96 Mineral 

Mix) 
50.00 g 

Vitamin Choline Bitartrate 2.00 g 
Vitamin V10001C (AIN-76A Vitamin 

Mix, 10X Concentration) 
1.00 g 

Dye Dye, Red FD&C #40, Alum. 
Lake 35-42% 

0.05 g 

Total  858.15 g 
 
Caloric Information (Physiological Fuel Values): 
 
Protein: 20% Kcal 
Fat: 45% Kcal 
Carbohydrate: 35% Kcal 
Energy Density: 4.7 Kcal/g 
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D10012M – AIN-93M Mature Rodent Diet 

Data obtained from: https://researchdiets.com/formulas/d10012m 
 
Formulation: 
 

Class Description Ingredients Grams 
Protein Casein, Lactic, 30 Mesh 140.00 g 
Protein Cystine, L 1.80 g 
Carbohydrate Sucrose, Fine Granulated 100.00 g 
Carbohydrate Lodex 10 125.00 g 
Carbohydrate Starch, Corn 495.69 g 
Fiber Solka Floc, FCC200 50.00 g 
Fat Soybean Oil, USP 40.00 g 
Mineral S10022M (AIN-93 Mineral 

Mix for Mature Rodents) 
35.00 g 

Vitamin Choline Bitartrate 10.00 g 
Vitamin V10037 (Vitamin Mix for AIN-

93 Rodent Diets) 
2.50 g 

Anti-oxidant Tert-Butylhydroquinone 0.01 g 
Total  1000.00 g 

 
Caloric Information (Physiological Fuel Values): 
 
Protein: 15% Kcal 
Fat: 9.4% Kcal 
Carbohydrate: 76% Kcal 
Energy Density: 3.81 Kcal/g  
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APPENDIX C – ENDPOINT MONITORING SYSTEM 
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APPENDIX D – BEHAVIOUR TEST PROTOCOLS 

The following protocols were originally created by the University of Ottawa Behavioural Core and 

have been included with their permission. The protocols have been adapted to reflect this specific 

study. 

Body Composition – EchoMRI 

Prior to Day of Testing  
 

1. Ensure the machine is turned on at least one day before testing is scheduled. 
 

Day of Testing 
 
SETUP 

1. Log on to the computer. 
2. Open the Echo software program on the desktop. 
3. Select Folder > Browse/New and choose the appropriate experimental folder. 

• If creating a new folder, it must be located within the EchoScans folder. 
4. Select the species (Mice) from the drop down list on the right hand side of the screen. 
5. Set the Primary Accumulation to 1. 
6. Set Water Stage to No.  
 
System Test 
1. Insert the test probe with the oil-filled bottle into the MRI. Put the shorter end in first, then 

push it in as far as possible.  
2. Select System Test > Yes. When finished, you will see System Test Completed 

Successfully. 
• Run a system test at the beginning of every experiment. 

3. If the test was not successful, the machine will automatically calibrate itself and re-run the 
system test. 

 
BEGIN TESTING 
1. Place the animal in the appropriately sized red plastic tube (maximum weights are printed 

on the tubes; for mice, a size 40 tube is acceptable for mice 20-60g).  
• Place the animal into the open end of the tube. If you are having difficulties getting 

a mouse into the tube, hold the tube horizontally and hold the mouse by the base 
of its tail near the opening of the tube to encourage hiding behavior.  

• Gently push the animal to the end of the tube with the plastic insert. 
• Leave enough space for the length of the animal’s body, not including the tail.  
• Ensure the animal is NOT compressed in the tube. Too little space can result in 

suffocation. It is better to give the animal too much space than too little as animal 
movement will not affect EchoMRI readings.  

• Use the Velcro to secure the insert in place. 
2. Place the tube inside the machine, with the end of the tube holding the animal going in 

first. Push the tube in as far as possible, being careful not to push the insert and injure the 
animal. 

3. Select Start Scan. 
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4. Input the mouse ID (and any other data/comments) in the dialog box. 
• These can be added or edited later if necessary. 
• NOTE: the placement of the plastic insert MUST NOT be adjusted while the tube 

is inside the machine. The tube MUST be removed from the machine and the 
mouse fully visible in the tube for any adjustments to the placement of the plastic 
insert to be made. 

5. When finished, you will see Scan ALL DONE in the dialog box. 
• Each scan takes roughly two minutes, meaning the mouse will spend less than 

three minutes in the test tube.  If technical issues are encountered that require 
troubleshooting, remove the mouse from the tube and replace it in its home cage.  
Do not leave the mouse in the sample tube for more than five minutes. 

6. Remove the mouse from the machine and place it back in its home cage. 
7. Clean the tube. Do not use alcohol or alcohol-based products. 
8. Repeat for all mice. 

 
EXPORT 

1. Highlight the desired trials from the list. 
2. Select Review > Extract Table. 
3. Choose the destination folder and name the file. 

 
Metabolic Activity - CLAMS 

Prior to Day of Testing  
 

1. Ensure the apparatus is turned on at least one day before testing is scheduled. 
 

Day of Testing 
 
SETUP 
Prepare chambers. 

1. Assemble as many housing chambers as needed for your experiment; one per mouse, to 
a maximum of 12.  

2. Fill the food chambers with a powdered variety of their normal diet.  
i. Fill the clear tube 1/3 full with powdered food. 
ii. Invert the tube (so the grate is facing down) and insert the metal plunger. 
iii. Place the spring on top of the plunger. 
iv. Using the red-handled tool, feed the tool through the bottom of the black 

holder and through the spring. The metal post fits into the post on the 
feeder. You should not have to hold both in place. 

v. Set the feeder down so the grate is on a flat surface (some food will fall 
out). Push the black holder into the clear tube and turn to lock it into place. 

vi. Remove the red-handled tool and flip the feeder chamber over. 
vii. Top up the feeder if any food was lost in the “locking” process. Compress 

a small mound of food on the top of the feeder, over the metal grate, to 
facilitate food access for the mice.  

viii. It is ok if there is food in the black holder- it does not need to be completely 
clean. 

3. Fill the water bottles all the way with clean water. Make sure to use the water from pre-
filled ACVS bottles, not tap water. Screw the sipper on tightly and shake upside-down until 
bubbles no longer rise to ensure water has filled the sipper and there are no blockages. 
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Assemble chamber components within the temperature-controlled unit. 
1. Gently place the filled food chambers on the black load cell. The load cells is very sensitive 

and could be damages so avoid pushing down very hard.  
2. Place the assembled cage chamber into position, carefully lining up the food access tube.  
3. Secure the IR framework to the cage chamber using the clips on the front and back of the 

chamber. 
4. Insert the water bottle into the hole at the back, right side on the top of the cage. Push it 

down as far as possible- the black base of the sipper should be touching the top of the 
cage. Screw the bottle into place using the white plastic nut attached to the cage top. 

 
Computer Setup 

7. Open the Oxymax software program on the desktop. Note: The software must be open for 
1 hour before calibrating the system. 

8. Select Use Default Hardware Configuration (green checkmark) option. 
9. Select File > Open Experiment Configuration.  
10. Select File > Save Experiment Configuration As. Choose a name (usually the lab and 

date) and destination folder for the experiment such as C/BData/Your lab/your 
folder/CLAMS date 

11. Select Experiment > Properties. Select the Environment tab. Under the Temperature 
Control tab, change the temperature in both the Start and End columns to the desired 
temperature. The Duration should be 4320 minutes (72 hours). Select Save to Controller. 
Ensure the Loop Schedule box is selected. 

i. Select Add Step to add another row to the schedule. Insert the desired 
temperature and duration in minutes.  

ii. When the Loop Schedule box is selected, the schedule will repeat every 
24 hours. If you would like a different schedule each day, uncheck that box 
and calculate the minutes appropriately. White lines will appear in the 
bottom purple box where steps have been added, to give a visual 
representation of where the steps take place throughout the experiment. 

iii. Select Save to Controller when finished. 
12. The Lighting Control (Experiment > Properties) is set up similar to the Temperature Control 

detailed above. The light schedule is set to change at 7am and 7pm, with each phase 
being 12 hours (720 minutes) in duration. Scheduled steps can also be added similar to 
the Temperature steps described above. 

13. Select Experiment > Setup. Select the appropriate Data Filename by selecting Browse. 
Save the file under C/BData/Your lab/your folder. Enter the Subject IDs into the table. 
Make sure each chamber that you will be using is checked. Enter the Mass of the animals 
as 1. 

• Either before or immediately after your CLAMS experiment, put the mice through 
the EchoMRI to get a more accurate measurement of body mass composition. Do 
not enter 0. Select Done when finished. 

 
Calibration 

1. Make sure the software has been open for at least 1 hour before beginning this procedure. 
2. Select Experiment > Calibrate. 
3. Ensure both the O2 (%) and CO2 (%) boxes are checked. Also ensure the values entered 

under the Span column match the values on the mixed gas tank. The values will be printed 
on the card attached to the tank. 

4. Select Start. A pop up box will ask you to open both the nitrogen and mixed gas tanks. 
You should feel the gas flowing through the yellow and clear tubes on the bottom shelf of 
the table. 
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• The left-most gauge should read 5-7 PSI on both the nitrogen and mixed gas tanks. 
5. Follow the prompts on the screen. The progress bar shows how long each step will take. 
6. When prompted (the status bar will say “Waiting on User”) to adjust the O2 offset, use the 

fine and coarse adjustment knobs to set the value on the screen as close to 0 as possible. 
The value on the screen turns from orange to green when in the proper range. 

• The left-most knob is the coarse adjustment, the center knob is the fine adjustment. 
7. Continue with the calibration. 
8. When prompted (the status bar will say “Waiting on User”) to adjust the O2, use the Span 

knob to set the value as close to 20.5 as possible. The value on the screen turns from 
orange to green when in the proper range. 

• The right-most knob is the Span knob. 
9. Once completed, a pop up box will indicate to close the gas tanks. 

 
BEGIN TESTING 

1. Place each mouse into its corresponding cage chamber. Unlatch the IR framework and lift 
it slightly to allow enough space to place the mouse inside. Latch the framework back into 
place. 

2. Select Experiment > Run. The program will run indefinitely. 
3. The mice should be given at least 24 hours to acclimate to the chambers. Any data 

collected during this time should not be used. It is recommend collecting data for 72 hours 
to ensure 2 full light cycle changes worth of data are collected. 

• It is not recommended that experiments go for more than 7 days without cleaning 
the cages. 

4. If feeding chambers need to be refilled, select Tools > Feeding > Refill Feeders. Chambers 
indicated in orange/red are getting low and need to be refilled. It can be very difficult to 
visually tell if the feeders are low on food since the IR framework blocks the top of the 
feeder. To refill the feeder: 

• Ensure the software is not measuring the desired chamber by checking the blue 
lights on the top of the unit.  

• Unselect the Enable box for the feeder you will be refilling.  
• Open the fridge unit and remove the feeder tube.  
• Refill the tube as quickly as possible.  
• Gently place the feeder chamber back in the appropriate position on the load cell. 
• Check the box to enable that feeder once again. The cell should turn green and go 

back to 0. 
5. Fill out the wellness sheet and place on the outside of the door. The mice need to be 

visually checked every day. 
• Do not open the fridge unit when checking the mice. Look through the glass doors. 

The doors have blackout panels Velcro-ed to the outside that can be removed.  
• Put the panels back on the doors when finished. 

 
WHEN TESTING IS COMPLETE 

1. Select Experiment > Stop. 
2. Remove the mice from the chambers and put back in their home cages. 
3. Select File > Export > Export Parameters. Check the desired metrics in the Available box 

and select >> to add them to the Selected box. Select the desired Parameter Type. All 
parameters from each Parameter Type can be added to the same file (no need to export 
three times for each of the three Parameter Types). 

4. Select Browse Path to select a save location. Create a new folder to save all exports in- 
each mouse is exported in its own CSV file. 
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Beam Break (BBK) 

Prior to Day of Testing  
 

1. If mice are grouped housed: 
• One day prior to testing, mark the tails of the mice with a permanent marker 

to easily identify the mice without handling.  
If mice are individually housed: 

• They should be individually housed for ~ 1 week prior to testing to ensure 
they have habituated to individual housing conditions 

 
Day of Testing 
 
SETUP 

1. Set the light in the room to the desired brightness using a Lux-meter. 
2. If testing overnight, ensure the lighting schedule is set so that the lights will turn on and off 

at 7AM and 7PM, respectively. 
3. Place a clean shoebox mouse cage into each of the metal frames, one cage per mouse 

being tested. The metal frames are numbered.  
• Dump out excess bedding. In each cage you want just enough bedding to cover 

the floor of the cage, so as to not interfere with the sensors. 
• Do not place house or nesting square in the test cage.  
• If testing overnight, add the specific mouse diets and water to the metal hopper.  
• Only use metal hoppers which do not rock when placed in a cage. 
• Ensure each cage is positioned so that it does not rock or wobble from side to side 

when in the frame.  
4. Bring your mice to the testing room and leave them to habituate for 30-60 minutes. 

• Close the door and turn over the “Do Not Disturb” sign hanging outside of the door 
to ensure that no one will enter during testing.  

• If testing overnight, fill out the “Temporary Housing Notes” document and leave on 
the outside of the door. 

5. Log on to the computer. 
6. Turn on the Micromax analyzer. 

• Make sure it is connected to the laptop via USB 
7. Open Fusion 5.3 for Micromax on the desktop. 

• If you see the message “The nodes connected to the system have changed”, click 
OK. A second message may pop up regarding the node assignment; select 
Accept. 

8. Under Tools, select Experiment settings. 
• Global: 

• Experiment Directory: Select “BData/your lab/your folder”. 
• Sample Duration (in seconds): For sampling every 5 minutes, enter 300 

seconds and for sampling every hour, enter 3600 seconds. The minimum 
interval for collecting the data is 10 sec. 

• Locomotor Variables: 
• Pre-Check. Do not select.  
• Insertion Auto start. If selected, the recording will start for 

automatically for each cage when the animal is detected in that 
cage. 

• Tail length /Tail Fade and Tail thickness are not to be used. 
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• Click Apply, and then OK. You will return to Fusion program screen. 
9. Create a new experiment by selecting File > New experiment. 

• An experiment properties dialog box will open. 
o On the left side of the screen select the cages you want to use for the 

experiment. There are 24 cages available for the test.  
o Click OK  

• The experimental details box will open. Fill in the following details. 
o Duration (min). For a 24hr experiment, enter 1440 (24 hr x 60 min). 
o Fill in the ID of the mouse in each cage. (You can also record this on a 

piece of tape affixed to the lid of each cage) 
o Fill in any other desired details. 

• Select OK when finished. 
  

NOTE: Never unplug the cords going into the metal frames if a box is not working. If a box is not 
working and you do not need all 24 boxes, then just use another box and ask for a Behavioural 
Core technician to fix the box.  
 
BEGIN TESTING 

1. On the Fusion page, the list of cages and mouse numbers will be displayed in the top left 
portion of the screen. All of the cages should say “Ready”. 

2. Click on the first cage so it is highlighted in blue. Click “Record Selected” above the cage 
list. 

• The cage will now say “Insert Animal”. 
3. Place the mouse in the cage and cover with a cage lid. 

• It will now say “Recording” in green and be counting down the time of the test. 
4. Repeat for all mice. Move as quickly and quietly as possible to minimize disruption to the 

mice already recording.  
5. When all mice are loaded, leave the room and close the door. 

 
WHEN TESTING IS COMPLETE 
 
NOTE: Ensure the Micromax box is turned off before unloading mice or cages. 

1. The test will automatically stop once the time set for the test has expired.  
2. The word “Complete” will appear in each of the boxes when the test is finished.  
3. Exit the Fusion program.  
4. Reopen the Fusion program. 

• You must close, then re-open the program in order to export the data. 
5. Select File > Open Experiment.  

• Your file is located on the C drive in your lab folder.  
6. Select File > Export.  
7. Select Comprehensive Output Data. Fill the field in the bottom left corner to specify the 

bin interval for the exported data (1 hour bin or 5 min bin) then select “Export”. Your files 
will automatically be saved in the BData folder. 

• The export file is in .csv format. It is recommended you open the file and save it 
again as an excel file. 

8. Turn off the Micromax analyzer before unloading mice or used cages from the BBK 
system. 

9. Log off the computer. 
10. Place the mice back in their home cages and return them to their regular housing room. 
11. Clean up the room and remove the dirty cages. 
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DATA ANALYSIS 
 

1. For data analysis, use the column: “Ambulatory Activity Count” which represents 
the number of beam breaks while the animal is ambulating. This parameter will not 
include the stereotypic behaviour.  

2. Any parameter such as Distance Traveled, and Movement Time would only report 
movements travelling in the x-axis direction (i.e. movements across the width of 
the cage, not the length). Y-axis data is not detected or reported with this system.  

3. Do not use the stereotypy measurements (i.e. rearing), including jumping, as it 
does not always agree with what we’ve scored by hand. The outputs Stereotype 
Count, Number of Stereotypy, and Stereotype Time are NOT valid outcomes with 
the Behaviour Core’s current BBK system.  

4. For data analysis using parameters other than “Ambulatory Activity Count, please 
consult with Behaviour Core staff, as many of the parameters given in the BBK 
output are not valid outcomes with this specific BBK system and setup.  

 
Forelimb Grip Strength 

Day of Testing 
 
SETUP 

1. Bring your mice to the testing room and leave to habituate for 30-60 minutes. 
• Turn over the “Do Not Disturb” sign hanging outside of the door to ensure 

that no one will enter during testing.  
 
BEGIN TESTING 
 

1. Always weigh each mouse before taking grip strength measurements, as grip data can be 
normalized using animal body weight.  

2. Press the power button to turn on the instrument.   
• The instrument is ready to use when a numerical value is displayed on the 

screen. 
3. Press the Zero key to reset the value to 0. 
4. Hold the mouse (see below for holding techniques) and gently move it close to the grid 

until the mouse grabs it with its front paws. Gently pull the mouse along a horizontal plane 
relative to the grid at a steady speed of ~ 2.5 cm/sec, until the animal releases the grid.  

• Pulling the mice away more slowly results in many mice prematurely releasing the 
bar with one or both paws.  

5. Record the value of force that is displayed on the screen in gram force (GF).  
• The instrument only displays the maximal value. 

6. Press the Zero key to clear the screen.  
• You may have to press it multiple times.  

7. Repeat for a maximum of 8 consecutive measurements for one animal.   
• Allow mice to rest for roughly 10 seconds between trials. 

8. Place the mouse back in its home cage.  
9. Repeat for all mice. 
10. When finished, log off of the computer, return the mice to their regular housing room, and 

clean the testing room. 
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Holding Techniques 
 
The method used for holding the mouse for the forepaw force measurement is very important for 
an accurate measurement. The results are highly repeatable if the mouse is handled in a 
consistent manner.   

 
There are 3 recommended methods:  
  
1. Hold the mouse around the midsection with the fingers and thumb curling under the body 

and the index finger on top, over the back and shoulders, with the tip of the finger by the 
mouse’s neck.  

2. Grasp the mouse by the scruff of the neck with one hand, and at the base of the tail with 
the other hand and bring it close to the grid until it can grip the bar.  

3. Hold the mouse from the base of its tail and lower it toward the base of the bar until it grips 
the bar with both forepaws. 

 
Tail Suspension 

Day of Testing 
 
SETUP 

1. Bring your mice to the testing room and leave to habituate for 30-60 minutes. 
• Turn over the “Do Not Disturb” sign hanging outside of the door to ensure 

that no one will enter during testing.  
2. Log on to the computer. 
3. Turn on the Tail Suspension Interface cabinet and ENV-505TS Load Cell Amplifier.  
4. Turn on the integration knob on the Tail suspension Interface cabinet DIG-735. The default 

position for the switch of the High pass filter on DIG-735 cabinet is 1 Hz. 
5. Open the Tail Suspension software program. 
6. Select File > Preferences. Set the following values: 

• Select the number of chambers to 4 
• Resolution to 200 msec and Graph history to 40 sec 
• Check “Save CSV Text summary files” to save a text summary file for your 

experiment  
• Check “CSV Batch Summary file” to save a CSV batch summary file  
• Check “Save CSV Raw data files” 
• Check “Automatic file Naming” to automatically name the data file based on 

Experiment, group and subject 
• Use the Browse button to select the directory where data files are stored: 

c/BData/Your Lab/TS/your name 
• Select “By Exp” the Data Subdirectory Options to create a subdirectory with the 

test name. When set to None, no subdirectory is created, and all data files are 
saved into the data directory. 

7. Select Experiment > Start experiment. 
• Click “Add experiment” and name a new experiment in Experiment ID field 
• Enter the experiment title then click OK to save the name 
• Fill the following values for each field: 

o Experiment time: 6 minutes 
o Upper Threshold: 50 
o Lower Threshold: 3  
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o Gain: 4 
o Block time: selected automatically when selected Number of Blocks  
o Number of blocks 12 (each block will be 30 sec allowing for a 6 min 

total testing time) 
o Start Trigger: 50. The experiment will automatically start when activity 

measured by the load meet the Start trigger value. 
o Press “Copy Data to all chambers” to have the same experimental 

setting for all the chambers 
o Enter the info for the Group, Subject ID, Subject info, Comment for each 

chamber 
 
BEGIN TESTING 

1. Clean the chambers with the solution provided. 
2. Make sure you have new tape available and already cut to an appropriate size for each of 

the mice.   
3. Press Start experiment.  

• Press Select all Chambers if you are using all 4; otherwise select the appropriate 
chambers. 

4. Click Start button.  
• The test will not start until the mouse is taped to the metal bar. 

5. Thread the mouse’s tail through a clear tube, then secure the end of the tail to the metal 
bar with tape. The ventral side of the mouse is facing the back wall of the chamber. 

• Position the clear tube so that there is a small gap between the tape and the tube. 
The tube should not be pressing into the mouse’s body. 

• Be VERY gentle when taping the mouse’s tail to the bar as it is very sensitive and 
can be damaged if too much force is applied. 

6. Tape all mice to the bars as quickly as possible. Leave the room and close the door when 
finished. 

7. The software will start automatically recording the data.  
• You should see the time counting down in the top corner of each chamber. 

8. After 6 minutes, the software will stop.  
• The software may ask you to save the trial once all chambers are stopped. In this 

case, name the file as per the trial number and save in the appropriate folder. 
9. Carefully take the mouse off the metal bar. Remove the tape and plastic tube from their 

tail and return the mice to their home cage.   
• Remove the mice in the same order that they were first put on to minimize the total 

amount of time each mouse is suspended.  
10. Repeat for all mice, cleaning between trials. 
11. To add another trial to the same experiment, select Experiment > Start Experiment. Select 

the experiment name for the next group of 4 mice. Fill in the mouse numbers, etc as 
described above. 

 
WHEN TESTING IS COMPLETE 

1. View > View raw data file to see the raw data or View CSV Batch Summary file to see the 
CSV data 

2. Select the test you want to see and click Open.  
3. Save CSV Batch Summary file as an Excel file in your labs folder – C:\BData\Lab Folder 
4. When finished, log off of the computer, return the mice to their regular housing room, and 

sweep the testing room. 
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APPENDIX E – OTHER PROTOCOLS USED IN THE THESIS 

Exercise Training 

Acclimation 
 

1. On the 1st day of testing, allow mice to habituate to the testing room for a minimum of 30 
minutes. 

2. Gently place each mouse in the treadmill, one mouse per lane. 
3. Turn the speed to a maximum of 10m/min and allow the mice to run for no longer than 

10 minutes. 
4. Repeat steps 2-3 until all mice have been trained. Between each round, make sure to 

clean the lanes and the dividers with an anti-septic solution (70% ethanol works well). 
 
Training – Week 1 
 
Frequency: 3x/week 
Intensity: 

- Warm up: 8 m/min 
- Training: 10 m/min 
- Cool down: 8 m/min 

Time:  
- Warm up: 10 min 
- Training: 25 min 
- Cool down: 8 min 

Type: Endurance Exercise 
 
Training – Week 2 
 
Frequency: 3x/week 
Intensity: 

- Warm up: 8 m/min 
- Training: 10 m/min 
- Cool down: 8 m/min 

Time:  
- Warm up: 10 min 
- Training: 35 min 
- Cool down: 5 min 

Type: Endurance Exercise 
 
Training – Week 3 
 
Frequency: 3x/week 
Intensity: 

- Warm up: 8 m/min 
- Training: 10 m/min 
- Cool down: 8 m/min 

Time:  
- Warm up: 10 min 
- Training: 45 min 
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- Cool down: 5 min 
Type: Endurance Exercise 
 
Training – Week 4 
 
Frequency: 3x/week 
Intensity: 

- Warm up: 10 m/min 
- Training: 10 m/min 
- Cool down: 8 m/min 

Time:  
- Warm up: 10 min 
- Training: 45 min 
- Cool down: 5 min 

Type: Endurance Exercise 
 
Training – Weeks 5 - 18 
 
Frequency: 3x/week 
Intensity: 

- Warm up: 10 m/min 
- Training: Increase speed by 1 m/min (starting at 11 m/min on week 5) until you reach 24 

m/min (week 18) 
- Cool down: 8 m/min 

Time:  
- Warm up: 10 min 
- Training: 45 min 
- Cool down: 5 min 

Type: Endurance Exercise 
 
Training – Weeks 18 – 56 
 
Frequency: 3x/week 
Intensity: 

- Warm up: 10 m/min 
- Training: 24 m/min 
- Cool down: 8 m/min 

Time:  
- Warm up: 10 min 
- Training: 45 min 
- Cool down: 5 min 

Type: Endurance Exercise 
 
Training – Weeks 56 – End of study 
 
Frequency: 2x/week 
Intensity: 

- Warm up: 10 m/min 
- Training: 24 m/min 
- Cool down: 8 m/min 

Time:  
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- Warm up: 10 min 
- Training: 45 min 
- Cool down: 5 min 

Type: Endurance Exercise 
 
Necropsy 

Materials 
 

• 5, 50 mL conical tubes (label each one with the mouse ID, organ and fixative) for the 
following organs: 

o Spleen 
o Liver 
o Heart 
o Lung 
o Brain 

• 1, 15 mL conical tube (labelled with the mouse ID and fixative) 
• ~100 mL of 10% NB formalin 

o Note: hematological tissues like spleen and liver require ~30-40mL of formalin to 
be properly fixed and prevent autolysis 

• Dissection tools (Do not need to be sterile but should be cleaned well with ethanol or 
other anti-septic solution after use) 

o Sharp scissors 
o Tweezers 
o Scoopula 

• KimWipes 
• Scale (ACVS Procedure Room has a more accurate scale) 

 
Organ Dissection 
 

1. Thoroughly spray the dead mouse with ethanol or anti-septic solution to prevent the fur 
from sticking to the scissors. 

2. Staring from the bottom and making your way up, cut away the skin and muscle layers in 
the abdomen all the way up to the ribs. Alternatively, you can continue cutting through 
the ribs up to the chin. 

3. With your tweezers, carefully pull the intestines out of the way and push the stomach 
towards your left to reveal the spleen. It is generally tucked behind the stomach and 
appears dark red and oblong. To remove, cut on either side of the spleen. 

4. Weigh and document the weight of the spleen and transfer to labelled 50mL conical 
tube. 

5. To remove the liver, cut away the diaphragm (thin transparent sheet between liver and 
lungs). It is often easiest to carefully push the liver to one side to reveal more of the 
diaphragm on the lateral aspects of the liver. Note: the liver is very delicate and can be 
damaged quite easily. 

6. Weigh and document the weight of the liver and transfer to labelled 50mL conical tube. 
7. Cut through the ribs and either with your hands or tools, spread the rib cage apart. 
8. Continue to cut up to the chin until you can see the trachea (tube with ring-like 

appearance). 
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9. With your tweezers, pull up from the trachea to remove the heart and lungs together. If 
this doesn’t work, carefully cut away the connective tissue below and surrounding the 
heart and lungs. 

10. Separate the heart from the lungs. 
11. Weigh and document the weights of the heart and lungs and transfer each to their 

respective labelled 50mL conical tube. 
12. Decapitate the mouse at the cervical spine. Note: to collect brain, it is important not to 

cervically dislocate the mice after asphyxiation as this can damage the brain. 
13. Cut away the skin and muscle on the top of the head to reveal the skull. 
14. VERY carefully, hold your scissors parallel to the table and superficially cut around the 

skull, starting from the back and cutting around the sides of the skull. Note: Going too 
deep or having your scissors perpendicular to the floor can potentially damage the brain. 

15. Use your tweezers to grab the back of the skull and pull up to remove it.  
16. With a scoopula, gently slide it along the later border of the skull and underneath the 

brain. 
17. Pull up and back to dislodge the brain. 
18. Weigh and document the weight of the brain and transfer to labelled 50mL conical tube. 

 
Femur Dissection 
 

1. Run your fingers gently up the femur until you get to the hip. With your scissors, cut 
around the hip to ensure you don’t break the femur head. 

2. Once removed from the body, begin cutting away the hip bone and any excess 
muscle/connective tissue. Note: Using a KimWipe makes cleaning the bone a lot easier. 
It is almost impossible to remove everything from the bone but you should be able to at 
least see the femoral head. At the distal end of the femur, there is a piece of cartilage 
that should be removed also to clean the bone further. 

3. Repeat 1-2 with the other leg. 
4. You can place both femurs in the same 15 mL conical tube but ensure there is at least 5-

6 mL of 10% NB Formalin. 
5. Place the tube with both femurs on the shaker at room temperature with gentle agitation 

for 48 hours. 
6. After 48 hours, place both femurs in a cassette and rinse them under cool running water 

for 1 hour. 
7. For histology, the femurs should be placed immediately in 14% EDTA solution for 14 

days. 
8. After 14 days, place the femurs in a cassette and rinse them under cool running water 

for 1 hour. 
9. Store the femurs in a 2mL Eppendorf tube filled with 70% ethanol at 4oC until ready for 

processing, embedding and sectioning. 
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APPENDIX F – STATISTICAL ANALYSES USING RSTUDIO 

library(epiR) 

## Loading required package: survival 

## Package epiR 1.0-14 is loaded 

## Type help(epi.about) for summary information 

## Type browseVignettes(package = 'epiR') to learn how to use epiR for applie
d epidemiological analyses 

##  

## for incidence rate ratio calculations 
 
dat1 <- matrix(c(9,205,10,188),ncol=2,byrow = TRUE) 
colnames(dat1) <- c("Disease +","Time at Risk") 
rownames(dat1) <- c("Expose +","Expose -") 
pred1 <- epi.2by2(dat1,method = "cohort.time",conf.level = 0.95,units = 100,o
utcome = "as.columns") 
dat2 <- matrix(c(16,236,10,188),ncol=2,byrow = TRUE) 
colnames(dat2) <- c("Disease +","Time at Risk") 
rownames(dat2) <- c("Expose +","Expose -") 
pred2 <- epi.2by2(dat2,method = "cohort.time",conf.level = 0.95,units = 100,o
utcome = "as.columns") 
dat3 <- matrix(c(10,192,10,188),ncol=2,byrow = TRUE) 
colnames(dat3) <- c("Disease +","Time at Risk") 
rownames(dat3) <- c("Expose +","Expose -") 
pred3 <- epi.2by2(dat3,method = "cohort.time",conf.level = 0.95,units = 100,o
utcome = "as.columns") 
pred1 

##              Outcome +    Time at risk        Inc rate * 
## Exposed +            9             205              4.39 
## Exposed -           10             188              5.32 
## Total               19             393              4.83 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc rate ratio                               0.83 (0.30, 2.26) 
## Attrib rate *                                -0.93 (-5.30, 3.44) 
## Attrib rate in population *                  -0.48 (-4.43, 3.46) 
## Attrib fraction in exposed (%)               -21.16 (-236.99, 55.75) 
## Attrib fraction in population (%)            -10.02 (-29.57, 12.37) 
## ------------------------------------------------------------------- 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 units of population time at risk 

pred2 
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##              Outcome +    Time at risk        Inc rate * 
## Exposed +           16             236              6.78 
## Exposed -           10             188              5.32 
## Total               26             424              6.13 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc rate ratio                               1.27 (0.54, 3.14) 
## Attrib rate *                                1.46 (-3.22, 6.14) 
## Attrib rate in population *                  0.81 (-3.24, 4.87) 
## Attrib fraction in exposed (%)               21.54 (-83.88, 68.17) 
## Attrib fraction in population (%)            13.26 (-8.87, 36.32) 
## ------------------------------------------------------------------- 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 units of population time at risk 

pred3 

##              Outcome +    Time at risk        Inc rate * 
## Exposed +           10             192              5.21 
## Exposed -           10             188              5.32 
## Total               20             380              5.26 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc rate ratio                               0.98 (0.37, 2.62) 
## Attrib rate *                                -0.11 (-4.72, 4.50) 
## Attrib rate in population *                  -0.06 (-4.08, 3.97) 
## Attrib fraction in exposed (%)               -2.13 (-173.40, 61.85) 
## Attrib fraction in population (%)            -1.06 (-20.34, 20.66) 
## ------------------------------------------------------------------- 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 units of population time at risk 

## for relative risk 
 
##comparing to CTRL-SED 
dat4 <- matrix(c(9,9,10,9),ncol=2,byrow = TRUE) 
colnames(dat4) <- c("Disease +","Disease -") 
rownames(dat4) <- c("Expose +","Expose -") 
pred4 <- epi.2by2(dat4,method = "cohort.count",conf.level = 0.95,units = 100,
outcome = "as.columns") 
dat5 <- matrix(c(16,3,10,9),ncol=2,byrow = TRUE) 
colnames(dat5) <- c("Disease +","Disease -") 
rownames(dat5) <- c("Expose +","Expose -") 
pred5 <- epi.2by2(dat5,method = "cohort.count",conf.level = 0.95,units = 100,
outcome = "as.columns") 
dat6 <- matrix(c(10,6,10,9),ncol=2,byrow = TRUE) 
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colnames(dat6) <- c("Disease +","Disease -") 
rownames(dat6) <- c("Expose +","Expose -") 
pred6 <- epi.2by2(dat6,method = "cohort.count",conf.level = 0.95,units = 100,
outcome = "as.columns") 
##comparing to CTRL-EX 
dat7 <- matrix(c(10,9,9,9),ncol=2,byrow = TRUE) 
colnames(dat7) <- c("Disease +","Disease -") 
rownames(dat7) <- c("Expose +","Expose -") 
pred7 <- epi.2by2(dat7,method = "cohort.count",conf.level = 0.95,units = 100,
outcome = "as.columns") 
dat8 <- matrix(c(16,3,9,9),ncol=2,byrow = TRUE) 
colnames(dat8) <- c("Disease +","Disease -") 
rownames(dat8) <- c("Expose +","Expose -") 
pred8 <- epi.2by2(dat8,method = "cohort.count",conf.level = 0.95,units = 100,
outcome = "as.columns") 
dat9 <- matrix(c(10,6,9,9),ncol=2,byrow = TRUE) 
colnames(dat9) <- c("Disease +","Disease -") 
rownames(dat9) <- c("Expose +","Expose -") 
pred9 <- epi.2by2(dat9,method = "cohort.count",conf.level = 0.95,units = 100,
outcome = "as.columns") 
##comparing to HFD-SED 
dat10 <- matrix(c(10,9,16,3),ncol=2,byrow = TRUE) 
colnames(dat10) <- c("Disease +","Disease -") 
rownames(dat10) <- c("Expose +","Expose -") 
pred10 <- epi.2by2(dat10,method = "cohort.count",conf.level = 0.95,units = 10
0,outcome = "as.columns") 
dat11 <- matrix(c(9,9,16,3),ncol=2,byrow = TRUE) 
colnames(dat11) <- c("Disease +","Disease -") 
rownames(dat11) <- c("Expose +","Expose -") 
pred11 <- epi.2by2(dat11,method = "cohort.count",conf.level = 0.95,units = 10
0,outcome = "as.columns") 
dat12 <- matrix(c(10,6,16,3),ncol=2,byrow = TRUE) 
colnames(dat12) <- c("Disease +","Disease -") 
rownames(dat12) <- c("Expose +","Expose -") 
pred12 <- epi.2by2(dat12,method = "cohort.count",conf.level = 0.95,units = 10
0,outcome = "as.columns") 
##comparing to HFD-EX 
dat13 <- matrix(c(10,9,10,6),ncol=2,byrow = TRUE) 
colnames(dat13) <- c("Disease +","Disease -") 
rownames(dat13) <- c("Expose +","Expose -") 
pred13 <- epi.2by2(dat13,method = "cohort.count",conf.level = 0.95,units = 10
0,outcome = "as.columns") 
dat14 <- matrix(c(9,9,10,6),ncol=2,byrow = TRUE) 
colnames(dat14) <- c("Disease +","Disease -") 
rownames(dat14) <- c("Expose +","Expose -") 
pred14 <- epi.2by2(dat14,method = "cohort.count",conf.level = 0.95,units = 10
0,outcome = "as.columns") 
dat15 <- matrix(c(16,3,10,6),ncol=2,byrow = TRUE) 
colnames(dat15) <- c("Disease +","Disease -") 
rownames(dat15) <- c("Expose +","Expose -") 
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pred15 <- epi.2by2(dat15,method = "cohort.count",conf.level = 0.95,units = 10
0,outcome = "as.columns") 
pred4 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +            9            9         18              50.0 
## Exposed -           10            9         19              52.6 
## Total               19           18         37              51.4 
##                  Odds 
## Exposed +        1.00 
## Exposed -        1.11 
## Total            1.06 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               0.95 (0.51, 1.78) 
## Odds ratio                                   0.90 (0.25, 3.27) 
## Attrib risk *                                -2.63 (-34.84, 29.58) 
## Attrib risk in population *                  -1.28 (-28.91, 26.35) 
## Attrib fraction in exposed (%)               -5.26 (-97.40, 43.87) 
## Attrib fraction in population (%)            -2.49 (-38.07, 23.92) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 0.026 Pr>chi2 = 0.87 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred5 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           16            3         19              84.2 
## Exposed -           10            9         19              52.6 
## Total               26           12         38              68.4 
##                  Odds 
## Exposed +        5.33 
## Exposed -        1.11 
## Total            2.17 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               1.60 (1.00, 2.56) 
## Odds ratio                                   4.80 (1.04, 22.10) 
## Attrib risk *                                31.58 (3.78, 59.38) 
## Attrib risk in population *                  15.79 (-11.09, 42.67) 
## Attrib fraction in exposed (%)               37.50 (0.11, 60.89) 
## Attrib fraction in population (%)            23.08 (-3.60, 42.89) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 4.385 Pr>chi2 = 0.04 
##  Wald confidence limits 
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##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred6 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           10            6         16              62.5 
## Exposed -           10            9         19              52.6 
## Total               20           15         35              57.1 
##                  Odds 
## Exposed +        1.67 
## Exposed -        1.11 
## Total            1.33 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               1.19 (0.67, 2.10) 
## Odds ratio                                   1.50 (0.39, 5.81) 
## Attrib risk *                                9.87 (-22.79, 42.53) 
## Attrib risk in population *                  4.51 (-23.29, 32.31) 
## Attrib fraction in exposed (%)               15.79 (-49.05, 52.42) 
## Attrib fraction in population (%)            7.89 (-22.71, 30.87) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 0.345 Pr>chi2 = 0.56 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred7 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           10            9         19              52.6 
## Exposed -            9            9         18              50.0 
## Total               19           18         37              51.4 
##                  Odds 
## Exposed +        1.11 
## Exposed -        1.00 
## Total            1.06 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               1.05 (0.56, 1.97) 
## Odds ratio                                   1.11 (0.31, 4.04) 
## Attrib risk *                                2.63 (-29.58, 34.84) 
## Attrib risk in population *                  1.35 (-26.81, 29.51) 
## Attrib fraction in exposed (%)               5.00 (-78.16, 49.34) 
## Attrib fraction in population (%)            2.63 (-35.58, 30.07) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 0.026 Pr>chi2 = 0.87 
##  Wald confidence limits 
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##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred8 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           16            3         19              84.2 
## Exposed -            9            9         18              50.0 
## Total               25           12         37              67.6 
##                  Odds 
## Exposed +        5.33 
## Exposed -        1.00 
## Total            2.08 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               1.68 (1.02, 2.78) 
## Odds ratio                                   5.33 (1.14, 24.90) 
## Attrib risk *                                34.21 (5.88, 62.54) 
## Attrib risk in population *                  17.57 (-10.02, 45.15) 
## Attrib fraction in exposed (%)               40.62 (1.98, 64.03) 
## Attrib fraction in population (%)            26.00 (-3.04, 46.86) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 4.937 Pr>chi2 = 0.03 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred9 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           10            6         16              62.5 
## Exposed -            9            9         18              50.0 
## Total               19           15         34              55.9 
##                  Odds 
## Exposed +        1.67 
## Exposed -        1.00 
## Total            1.27 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               1.25 (0.69, 2.27) 
## Odds ratio                                   1.67 (0.42, 6.56) 
## Attrib risk *                                12.50 (-20.61, 45.61) 
## Attrib risk in population *                  5.88 (-22.61, 34.38) 
## Attrib fraction in exposed (%)               20.00 (-45.46, 56.00) 
## Attrib fraction in population (%)            10.53 (-22.84, 34.83) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 0.537 Pr>chi2 = 0.46 
##  Wald confidence limits 
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##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred10 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           10            9         19              52.6 
## Exposed -           16            3         19              84.2 
## Total               26           12         38              68.4 
##                  Odds 
## Exposed +        1.11 
## Exposed -        5.33 
## Total            2.17 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               0.62 (0.39, 1.00) 
## Odds ratio                                   0.21 (0.05, 0.96) 
## Attrib risk *                                -31.58 (-59.38, -3.78) 
## Attrib risk in population *                  -15.79 (-37.86, 6.28) 
## Attrib fraction in exposed (%)               -60.00 (-155.72, -0.11) 
## Attrib fraction in population (%)            -23.08 (-49.53, -1.30) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 4.385 Pr>chi2 = 0.04 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred11 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +            9            9         18              50.0 
## Exposed -           16            3         19              84.2 
## Total               25           12         37              67.6 
##                  Odds 
## Exposed +        1.00 
## Exposed -        5.33 
## Total            2.08 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               0.59 (0.36, 0.98) 
## Odds ratio                                   0.19 (0.04, 0.88) 
## Attrib risk *                                -34.21 (-62.54, -5.88) 
## Attrib risk in population *                  -16.64 (-38.92, 5.64) 
## Attrib fraction in exposed (%)               -68.42 (-178.05, -2.02) 
## Attrib fraction in population (%)            -24.63 (-51.93, -2.24) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 4.937 Pr>chi2 = 0.03 
##  Wald confidence limits 
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##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred12 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           10            6         16              62.5 
## Exposed -           16            3         19              84.2 
## Total               26            9         35              74.3 
##                  Odds 
## Exposed +        1.67 
## Exposed -        5.33 
## Total            2.89 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               0.74 (0.48, 1.14) 
## Odds ratio                                   0.31 (0.06, 1.54) 
## Attrib risk *                                -21.71 (-50.55, 7.13) 
## Attrib risk in population *                  -9.92 (-31.80, 11.95) 
## Attrib fraction in exposed (%)               -34.74 (-106.42, 12.05) 
## Attrib fraction in population (%)            -13.36 (-34.50, 4.46) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 2.143 Pr>chi2 = 0.14 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred13 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           10            9         19              52.6 
## Exposed -           10            6         16              62.5 
## Total               20           15         35              57.1 
##                  Odds 
## Exposed +        1.11 
## Exposed -        1.67 
## Total            1.33 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               0.84 (0.48, 1.49) 
## Odds ratio                                   0.67 (0.17, 2.58) 
## Attrib risk *                                -9.87 (-42.53, 22.79) 
## Attrib risk in population *                  -5.36 (-34.19, 23.48) 
## Attrib fraction in exposed (%)               -18.75 (-110.19, 32.91) 
## Attrib fraction in population (%)            -9.38 (-45.72, 17.91) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 0.345 Pr>chi2 = 0.56 
##  Wald confidence limits 
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##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred14 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +            9            9         18              50.0 
## Exposed -           10            6         16              62.5 
## Total               19           15         34              55.9 
##                  Odds 
## Exposed +        1.00 
## Exposed -        1.67 
## Total            1.27 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               0.80 (0.44, 1.45) 
## Odds ratio                                   0.60 (0.15, 2.36) 
## Attrib risk *                                -12.50 (-45.61, 20.61) 
## Attrib risk in population *                  -6.62 (-35.62, 22.39) 
## Attrib fraction in exposed (%)               -25.00 (-127.28, 31.25) 
## Attrib fraction in population (%)            -11.84 (-48.83, 15.95) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 0.537 Pr>chi2 = 0.46 
##  Wald confidence limits 
##  CI: confidence interval 
##  * Outcomes per 100 population units 

pred15 

##              Outcome +    Outcome -      Total        Inc risk * 
## Exposed +           16            3         19              84.2 
## Exposed -           10            6         16              62.5 
## Total               26            9         35              74.3 
##                  Odds 
## Exposed +        5.33 
## Exposed -        1.67 
## Total            2.89 
##  
## Point estimates and 95% CIs: 
## ------------------------------------------------------------------- 
## Inc risk ratio                               1.35 (0.88, 2.06) 
## Odds ratio                                   3.20 (0.65, 15.78) 
## Attrib risk *                                21.71 (-7.13, 50.55) 
## Attrib risk in population *                  11.79 (-16.01, 39.58) 
## Attrib fraction in exposed (%)               25.78 (-13.70, 51.55) 
## Attrib fraction in population (%)            15.87 (-9.87, 35.57) 
## ------------------------------------------------------------------- 
##  Test that OR = 1: chi2(1) = 2.143 Pr>chi2 = 0.14 
##  Wald confidence limits 
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##  CI: confidence interval 
##  * Outcomes per 100 population units 

 
 


